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Preface 

Before installing the product, please read this manual fully and make sure you follow the 

instructions in it. 

The content of the manual is maintained latest as of the date when it is written. The product 

information is subject to change without prior notice to users. 

If you are uncertain about any requirements, recommendations or safety procedures described 

in the manual, please, consult with Hanwha Precision Machinery Co., Ltd. 

Users are responsible for any damages caused by their misuse neglecting these instructions 

below. 

 

Note  Some of illustrations in the manual intends to help users in understanding the 

system concepts and installation issues. The actual product may differ from 

the manual. 

 Please keep this manual in a safe place for future reference. 

 Voltage : 100~240VAC, 50/60Hz(1kW)(It should be connected to the neutral 

cable which is connected with grounding line with one phase of the 3 phase 

cables.) 

 Status of load installation : Load is not exceeding the payload of Robot. 

 Please check the grounding line connection in plant and operating cell. 

(It can be refer to section 3.3 to check the location of grounding line.) 

- Any plants and cells with the inappropriate grounding line may have the 

negative influence such as noise on the communication line between robot and 

system. 

- Especially, if robot is installed with the equipment requiring large current 

such as heater, motor, separate additional grounding line is required. 
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Copyrights 

The copyrights and intellectual property rights of all the content and diagrams in the manual 

belong to Hanwha Precision Machinery Co. 

Thus, illegal use, duplication, distribution or dissemination of the manual without prior written 

approval by Hanwha Precision Machinery Co. is strictly prohibited and such an activity is an 

infringement of the intellectual property rights of Hanwha Precision Machinery Co. 

Users are responsible for any damages caused by their misuse or modification of the patent 

rights for the equipment. 

The information provided by the manual is deemed trustworthy by Hanwha Precision 

Machinery Co. Hanwha Precision Machinery Co. is not responsible for any situations arising 

due to inaccuracy or typo in the content of the manual. 

The information provided in the manual is subject to change without prior notice and for more 

details about revisions made in the manual, please visit the homepage of Hanwha Precision 

Machinery Co.(https://www.hanwharobotics.com) 

© Hanwha Precision Machinery Co., Ltd. All rights reserved 
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Chapter 1  Product Overview 

1.1 Collaborative Robot System 

Hanwha Precision Machinery's collaborative robot, HCR Series are user-friendly robot that 

provides an automation environment where it can safely collaborate next to humans in various 

fields. 

Easy setting 

By using the direct teaching feature and the intuitive S/W GUI, users can easily configure and 

control the robot. 

 While holding the robot gently, users can implement desired movements, so that the robot 

can detect and memorize movements. 

 Users can preview the robot movement in a real time 3D and use the icon based intuitive GUI 

for easy operation. 

 As the installation method is simple, even if users are not robot engineers, they can easily 

configure the initial setting and program the robot. 

Flexible rearrangement 

Users can easily rearrange the robot, so that it can be applied to various processes easily and 

quickly. 

 Since users can operate the robot in small space, it is possible to rearrange the robot without 

changing the layout of the manufacturing line. 

 The robot is light weighted and easy to move, and its simple programming environment 

allows the robot to be easily adapted to high-mix, low-volume production. 
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Safe collaboration 

Using the various safety features, users can safely work next to the robot without using 

additional safety tools or devices. 

 The robot is automatically stopped when it detects an impact, so as long as the working 

range of the robot and the user are guaranteed, it can be installed anywhere for safe use. 

 

 Caution 

For HCR-12 model, the serial number of controller and robot body must match. If it 

does not match, the following error message appears, 

Please check with the manager or Hanwha Precision Machinery C / S. 

 

 

 

 

 

 

 

 

 

  

[CODE 2043001] 
Calibration data of controller and robot body do 

not match. Please check with your administrator to 

see if the data match. The system will shut down. 
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1.2 System Components 

The following is a list of system components. 

Components HCR-3 HCR-5 HCR-12 Quantity 

Robot arm O O O 1 EA 

Robot controller O O O 1 EA 

Teaching pendant O O O 1 EA 

Teaching pendant fixing 

bracket 
O O O 1 EA 

Power cable O O O 1 EA 

8pin tool cable O 
  

1 EA 

12pin tool cable 
 

O O 1 EA 

Robot communication and 

power cable   
O 1 EA 

User manual O O O 1 EA 
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1.3 Basic System Configuration 

 

 

 

 Robot arm: It is an industrial collaborative robot that can be used to convey objects or 

assemble parts, and it can be used by attaching various tools such as grippers. 

 Robot controller: Can control the robot arm's various movements according to the program 

prepared by the user. It can be connected with various devices and equipment through its 

various I/O ports. 

 Teaching pendant(TP): It is a device used for system operation. It can teach the robot a 

specific position or control and configure the robot in many ways. 

 

  

Robot arm 
Robot controller 

Teaching 
pendant 

Power 
supply & 
network 

Command & 
monitoring 
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1.4 Overview of Robot Arms 

HCR-3 

 

 

➊ Tool Flange ➎ Lower Arm ➒ J1 

➋ J6 Wrist3 ➏ Elbow ➓ Base 

➌ J5 Wrist2 ➐ J3   

➍ J4 Wrist1 ➑ J2 Shoulder   
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No. Name Description 

 Tool flange 
It is the area in the robot where a tool is mounted. 

For more details, refer to 3.4 Connecting Tools to Robots. 

 Tool I/O 

It is the I/O port used to control a tool. 

For more details about specifications, refer to Appendix E. 
Port Pin Map. 

 LED 

Indicates the status of robot. 

 Green: Operation mode 

 Blue: Direct teaching mode 

 Red: Emergency stop mode  

 Pink: Exceeding joint range limits in direct teaching 

 Robot base It is the area in the robot that is fixed to the ground or wall. 
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HCR-5 

 

 

➊ Tool Flange ➎ Lower Arm ➒ J2 Shoulder 

➋ J6 Wrist3 ➏ Elbow ➓ J1 

➌ J5 Wrist2 ➐ J3  Base 

➍ J4 Wrist1 ➑ Upper Arm   
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No. Name Description 

 Tool flange 
It is the area in the robot where a tool is mounted. 

For more details, refer to 3.4 Connecting Tools to Robots. 

 Tool I/O 

It is the I/O port used to control a tool. 

For more details about specifications, refer to Appendix E. Port 
Pin Map. 

 EtherCAT 

It is the Ethernet based port used for communication with a tool. 

For more details about specifications, refer to Appendix E. Port 

Pin Map. 

 LED 

Indicates the status of robot. 

 Green: Operation mode 

 Blue: Direct teaching mode 

 Red: Emergency stop mode  

 Pink: Exceeding joint range limits in direct teaching 

 Robot base It is the area in the robot that is fixed to the ground or wall. 
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HCR-12 

 

 

➊ 

Tool Flange ➎ Upper Arm 

➋ J5_J6 ➏ J2 

➌ Lower Arm ➐ J1 

➍ J3_J4   
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No. Name Description 

 Tool flange 
It is the area in the robot where a tool is mounted. 

For more details, refer to 3.4 Connecting Tools to Robots. 

 Tool I/O 

It is the I/O port used to control a tool. 

For more details about specifications, refer to Appendix E. Port 
Pin Map. 

 EtherCAT 

It is the Ethernet based port used for communication with a tool. 

For more details about specifications, refer to Appendix E. Port 

Pin Map. 

 LED 

Indicates the status of robot. 

 Green: Operation mode 

 Blue: Direct teaching mode 

 Red: Emergency stop mode 

 Pink: Exceeding joint range limits in direct teaching 

 Robot base It is the area in the robot that is fixed to the ground or wall. 
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1.5 Overview of Robot Controller 

Front 

 

 

No. Name 

 Handle 

 Air exhaust hole (exhaust hole filter) 

 Air intake hole (intake hole filter) 

 Controller cover locking screw 

 Teaching pendant fixing hook 

 Controller fixing bracket 

 Teaching pendant fixing bracket 
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Bottom 

 HCR-3, HCR-5 

 

No. Name 

 Robot connector 

 Teaching pendant connector 

 Power button  

 AC power socket  

 

 HCR-12 

 

No. Name 

 Robot communication connector 

 Robot power connector 

 Power button  

 AC power socket  
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1.6 Overview of Teaching Pendant 

Front 

 

 

No. Name Description 

 Power button 

Turn on/off the power of the teaching pendant. 

For more details, refer to 4.2 Turning on the Teaching 

Pendant. 

 
Emergency stop 

button 

Press it to stop the robot. 

For more details, refer to 2.7 Emergency Stop. 

 Touch screen 
A resistive touch screen that detects a touch even if user wears 

a glove. 

 USB port 
USB 2.0 port that can be used by plugging in a USB memory, 

keyboard, mouse, etc.1 

1Some devices may not be compatible with the teaching pendant. 
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Rear 

 

 

No. Name Description 

 Handle 
Users can insert their hands and lift the teaching pendant for use. 

Users can turn the handle and insert their hand in the desired 

direction. 
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1.7 Axial Coordinates and Operational Range 

It consists of a total of six axes and an axis of each joint has the following coordinates and 

operational ranges. The direction of arrow indicates the (+) rotational angle and the opposite 

direction of arrow indicates the (-) rotational angle. 

 

HCR-3 

Axis Operation range Figure 

J1 -360° ≤ rz1 ≤ +360° 

 

J2 -360° ≤ rz2 ≤ +360° 

J3 -160° ≤ rz3 ≤ +160° 

J4 -360° ≤ rz4 ≤ +360° 

J5 -360° ≤ rz5 ≤ +360° 

J6 -∞ ≤ rz6 ≤ +∞ 

 

  

When the J3 axis is at +160° When the J3 axis is at -165° 
  

Note The J3 axis has a limited operational range due to its unique structure. 
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HCR-5 

Axis Operation range Figure 

J1 -360° ≤ rz1 ≤ +360° 

 

J2 -360° ≤ rz2 ≤ +360° 

J3 -165° ≤ rz3 ≤ +165° 

J4 -360° ≤ rz4 ≤ +360° 

J5 -360° ≤ rz5 ≤ +360° 

J6 -360° ≤ rz6 ≤ +360° 

 

  

When the J3 axis is at +165° When the J3 axis is at -165° 

 

Note The J3 axis has a limited operational range due to its unique structure. 
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HCR-12 

Axis Operation range Figure 

J1 -180° ≤ rz1 ≤ +180° 

 

J2 -165° ≤ rz2 ≤ +135° 

J3 -85° ≤ rz3 ≤ +245° 

J4 -190° ≤ rz4 ≤ +190° 

J5 -170° ≤ rz5 ≤ +170° 

J6 -360° ≤ rz6 ≤ +360° 

 

 

 

When the J3 axis is at -85° When the J3 axis is at +245° 

 

Note The J3 axis has a limited operational range due to its unique structure. 
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1.8 Robot's Working Range 

There is a radius (B) in which the robot arm can rotate at max extension, and an area (A) 

around the center axis that the robot arm is not able to reach due to the structure. Please refer to 

the following for more details. 

Type A B 

HCR-3 74.3mm 630mm 

HCR-5 176.5mm 915mm 

HCR-12 - 1,300mm 

 

HCR-3 

 

 A: Working range where the robot arm cannot reach 

 B: Working range where the robot arm can reach 
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HCR-5 

 

 A: Working range where the robot arm cannot reach 

 B: Working range where the robot arm can reach 
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HCR-12 
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1.9 Maximum load capacity for the tool 

The load capacity of the robot arm may vary depending on the distance between the tool flange 

and the payload's center of gravity. The load capacity per distance is as follows: 

HCR-3 
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HCR-5 
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HCR-12 
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Chapter 2  Safety 

2.1 Safety Marks in the User Manual 

The user manual contains the following safety marks. 

 

 Danger 
If a user does not obey the safety mark, then it can cause a severe accident including 

death or serious injury of a user. 

 

 Warning 
If a user does not obey the safety mark, then it can cause an accident including serious 

injury of a user. 

 

 Caution 
If a user does not obey the safety mark, then it can cause a damage to the product or 

injury of a user. 
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2.2 General Safety Cautions 

 Danger 
User needs to install the robot and the electrical equipment by complying with the 

instructions given in Chapter 3 Installation. 

 Warning 
• Robot application system manufacturers and robot users should be familiar with this 

manual and complete the robot operation training. 

• Make sure sufficient space is available so the robot arm can move freely. 

• When using the robot, a user should not wear loose clothes or accessories. If you have 

long hairs, then tie it in the back so that it does not stuck in the robot's joints. 

• Do not ever use a damaged robot. 

• If a fatal error occurs in the software, then immediately stop it and contact the product 

supplier.  

• Check if values such as the robot installation angle, tool settings and safety settings are 

correctly inputted. 

• Do not connect the safety device to a general I/O. Safety device is used only for safety 

related I/O. 

• When using the teaching pendant, pay close attention to the robot's movements. 

• When the robot is operating, do not enter the working range of the robot or touch the 

robot. 

• Do not modify the robot on your own. If a user causes a problem by modifying or 

remodeling the product on their own, then Hanwha Precision Machinery will not be 

responsible for it in any sort of way. 

• The robot and the controller can generate heat after long hours of use. Do not touch the 

robot after long hours of use. If you need to touch the robot, then power off the 

controller and cool down the robot first. 

• If the robot collides with an external object, a considerable impact occurs, the amount 

of which is proportional to the speed and payload. 

• Regarding the robot installation, make sure to use a proper configuration for 

installation. If robot mounting, tool weight, tool's center of gravity, tool length, safety 

configuration, etc. are not correctly entered, the direct teaching or collision detection 

function may not work properly. 

• You should use the direct teaching function in a safe environment. DO NOT use it if 

there is a sharp part or cause of jamming in a tool or surrounding installations. 

• Correctly enter tool related information (the length, weight, center of gravity of the tool, 

etc.) before using the direct teaching function. If you enter information different from 
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the actual specification of the tool, you may experience malfunction when using the 

direct teaching function. 

• If a joint is operated at the speed beyond a certain limit when using the direct teaching 

function, it may make an emergency stop for the safety of operators. 

• To activate/deactivate the direct teaching function, first make sure the robot is not 

moving. If the direct teaching function becomes activated/deactivated while the robot is 

operating or moving due to active direct teaching, the robot may malfunction. 
 

 Caution 

• It is recommended that you test all the functions separately before using the machine or 

other robot that can damage the robot. If other machine or robot is damaged by 

programming errors or robot failures, Hanwha Precision Machinery will not be 

responsible for it. 

• Do not expose the robot to a strong magnetic field. Your robot can be damaged. 

• GREASE of the drive may leak depending on environment and operating conditions. 

 

2.3 Intended Use 

This robot may be used for transport, and assembly of objects with tools. However, use it only 

under the environment specified by its specifications.  

Since the safety function is built in, the collaborative work is possible without physical 

protective fence. However, for the final system applied with robot, the risk assessment should be 

conducted on the whole system before use.  

The system integrator or the end user who implements the robot applied final system shall take 

the responsibilities as follows:  

(These are examples and are not limited to them.) 

 Use in potentially explosive environment. 

 Medical applications and human life related applications 

 Use in human and animal transportation 

 Use without the risk assessment 

 Use in places where the performance of the safety function is not sufficient 

 Use beyond its performance and environmental specifications 
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2.4 Potential Dangers 

If the risk assessment, conducted by the final system manufacturer who applied the robot, 

concludes that it is not possible to fully reduce the risk only with the built-in safety function, 

additional protective measures should be established. 

Consider potential dangers as follows: 

 Injuries that may occur if the human body part such as finger is caught in the robot joints 

(confinement). 

 Injuries caused by sharp edges or corners of tools (stab or penetration) 

 Injuries caused by objects around the robot (stab, penetration, or falling) 

 Injuries that may occur when working on toxic or hazardous materials (skin damage or 

dyspnea) 

 Injuries caused by collisions with the robot (bruise or fracture) 

 Injuries caused by loosely coupled parts. 

 Injuries caused by objects separated or fallen from the tool. 

Note Potential dangers that may occur vary depending on the final system. 

2.5 Limitation of Liability 

This user manual does not cover all of the peripherals affecting the safety. A system installer 

must comply with the safety requirements according to the safety rules and laws of the country 

where the robot is installed.  

The robot is configured as the final system interconnected with peripherals. This user manual 

covers neither the design, installation, operation of the final system nor all of the peripherals 

including the safety device. 

The final system which applied the robot shall be designed and installed according to the safety 

requirements in compliance with laws and regulations of the country where it is installed. 

The system integrator or the end user who implements the robot applied final system shall take 

the responsibilities as follows:   

(These are examples and are not limited to them.) 

 Risk assessment on the final system 

 Addition of safety devices according to the risk assessment results 

 To check whether the system is correctly designed, set up and installed 

 Definition on how to use the system 
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 Providing information on operation and safety as well as contact information 

 Provision of technical documents including the user manual 

Complying with the safety items in the user manual does not mean that all possible risks are 

prevented. 
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2.6 Transportation 

The weight of the robot arm of the HCR Series is as follows, and the weight of the robot 

controller is 20.2 kg. At least two (2) people are required for transportation and conveyance. 

Type Weight(Robot arm) 

HCR-3 13kg 

HCR-5 20.8kg 

HCR-12 52.5kg 

 

Carry the controller box by holding the handle at the top. 

 

 

 Warning 

During transportation, avoid damages caused by falling accidents. The warranty does not 

cover any damage caused during transportation. 
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2.7 Emergency Stop 

You can press the emergency stop button to immediately stop the robot in case of emergency. 

The emergency stop button is basically located in the teaching pendant and you can stop the 

robot by connecting another emergency stop button to the robot controller.  

 Caution 

In the event of a collision or an emergency stop while driving over the speed of 120°/sec, 

check the zeroing of the robot joint and calibrate it if needed. After that, check if the 

movement path of the tool set in the operating program is correct. Contact the manufacturer 

or the service representative if you need the zeroing adjustment. 

Using emergency stop 

You can press the emergency stop button in the teaching pendant to immediately stop the robot.  

 

Canceling emergency stop 

Turn the emergency stop button clockwise to cancel emergency stop. 

 

  



Chapter 3 Installation 

42 

2.8 Safety Fence 

Unlike other kinds of industrial robots that adopt physical fences, virtual fences are 

implemented to make sure that the TCP does not reach out of certain limits. For more details, 

refer to 8.2 Setting Safety Boundaries. 

2.9 Limits of Speed and Rotational Angles 

By limiting the rotational angle and speed of each joint, you can secure your safety. For more 

details, refer to 8.1 Limiting Robot Movement.  

2.10 Operating Robots without Driving Power 

In case of emergency, when the robot is not driven by power, an adult can move each axis with 

their own force.  

 Caution 

If you use excessive force to move the axis when the robot is not being driven by power, it 

can overload the driving unit. The manufacturer is not responsible for the failure caused by 

excessive force. 

2.11 Safety Controller 

The safety controller for HCR Series complies with the ISO13849 Cat3. PLd class. 
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2.12 Risk Assessment 

The risk assessment is one of the important factors when configuring a robot configured system. 

The degree of safety regarding robot installation varies depending on the way of integrating it 

into the entire system, so it is not possible to perform the risk assessment with the robot alone. 

The person who configures the robot included system to perform the risk assessment of the 

robot should install and operate it according to instructions of ISO 12100 and ISO10218-2 

standards. For further information, refer to the Technical Specification ISO/TS15066. 

You must perform the risk assessment right after the robot is installed. The main objectives of 

the risk assessment are to set up safety configuration suitable for the surrounding environment 

and robot settings and to find out the need for additional emergency stop buttons and protective 

measures. 

It is possible to configure functions related to safety of the collaborative robot from the Safety 

Configuration Setting menu. Available functions are as follows: 

 Joint Rotation Limit: You can limit the angle of each joint. 

 Joint Speed Limit: You can limit the speed of each joint. 

 TCP Speed Limit: You can limit the max speed for the TCP's linear movement. 

 Force Limit: You can limit the maximum force that stops the robot when it detects a 

collision with a surrounding object. 

 Safety Boundary Limit: You can build a virtual fence within the robot working area to 

prevent robot arms or tools from moving beyond the boundary for the safety of users. 

 Redundant I/O Setting: You can set up redundancy to an I/O terminal to input/output 

important safety-related information. 

If dangers are not sufficiently reduced or removed through the safety related functions above, 

add more protective measures to remove them. The manufacturer is not responsible for 

accidents caused by noncompliance with relevant requirements of international standards and 

local laws and regulations in relation to installation or due to not performing review on those 

requirements during the risk assessment as above. 
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Chapter 3  Installation 

The installer should install and operate the robot according to instructions of ISO 12100 and 

ISO10218-2 standards and comply with relevant requirements of international standards such 

as ISO/TS 15066 and local laws and regulations. 

The manufacturer is not responsible for accidents caused by noncompliance with relevant 

requirements of international standards and local laws and regulations or due to not performing 

review on the risk assessment as mentioned in Section 2.12. 

3.1 Installation Locations 

It is recommended to install the system in a place which meets conditions as follows: 

 A building with earthquake-resistant design 

 A place without water leaks 

 A place free of flammability or explosives 

 A place that maintains the constant temperature and humidity 

 A place with little dusts 

 Caution 

If the system is not installed in a recommended place, the performance and the life span of 

the robot may be reduced. 
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3.2 Installation Types 

The robot arm can be installed on the floor, walls or on the ceiling as shown below. HCR-12 

can only be installed on the floor and the ceiling. 

 

Example of installation on 

floor 

 

Example of installation on 

wall 

 

Example of installation on 

ceiling 

 

You can also install it on a moving dolly or fixed post. 

  

Example of installation on a moving dolly Example of installation on a fixed 

post 

 

 Warning 

If you install the robot on a moving dolly, you must make sure the moving dolly is fixed to 

the ground when operating the robot. 
 

Note The moving dolly or fixed post is not included in the product package. 
 

After installing the robot, you must configure the robot installation information depending on 

each type of installation. For more details, refer to 7.1 Setting the Robot installation Angles. 
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3.3 Fixing Robots 

The robot arm can be installed on the floor, walls or on the ceiling using four (4) bolts. It is 

recommended that the bolts be fastened with an appropriate torque. 

If the installation surface does not have the sufficient flatness and hardness to support the robot 

arm, a fixation base may be used to install the arm. If you intend to install the robot arm at a 

precise position, two (2) positioning pins may be used to determine the position. 

Additionally, the grounding line must be connected using the M4*10mm bolts in order to 

prevent static electricity. 

Type Bolt size Torque Positioning pin size 

HCR-3 M6, 15mm 30 Nm Φ5 

HCR-5 M8, 15mm 45 Nm Φ8 

HCR-12 M12, 25mm 140 Nm Φ5 

 

 

  

Connect the grounding line 
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 Warning 

 When fixing the robot, securely fasten the bolts to prevent them from getting loose.  

 Install it on a flat ground that can with withstand the robot's weight and the weight that 

is generated when the robot is operating.  

 Check that the installation plane of the robot arm is completely in contact with its base 

plane. 

 Do not arbitrarily remove bolts on the robot. Before operating the robot arm, make sure 

all bolts are securely tightened. Using the arm with a bolt removed or installing a bracket 

by using a unit with bolts attached may damage the product or seriously affect safety. 

 

Note  The base fixing bolt is not included in the product package. 

 For more details about specifications of the robot base, refer to Appendix C 

Dimensions for Installation. 
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3.4 Connecting Tools to Robots 

1. Using four sets of M6 bolts, fix a tool to the tool flange. 

 

 

 

Note  Tools and fixing M6 bolts are not included in the product package. 

 The tool combination method varies from tool to tool. For more detailed 

methods, refer to the user manual provided by the tool maker. 

 For more details about specifications of tool flange, refer to Appendix D. Tool 
Flange Cross Section. 

 

2. After fixing the tool, connect the necessary cables to the tool I/O or the EtherCAT port. 

 For the tool I/O, you can select one from the analog input (current (0 – 20 mA), voltage 

(0 – 10 V)), the digital input (4Ch) and the digital output (2Ch, 4Ch, 0, 12, 24 Vdc). 

 

 

Note  For more details about specifications of the pin maps for the tool I/O and the 

EtherCAT, refer to Appendix E. Port Pin Map. 
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3.5 Connecting Cables 

Connecting the teaching pendant to the robot controller 

After connecting the teaching pendant cable, by using fixing bolts for the connector, securely 

fasten it, so that the cable does not slip out. Be careful of pin being bended while connecting. 

The controller and the teaching pendant of the HCR-12 are integrated and do not require a 

separate connection. 

 

Connecting the robot arm to the robot controller 

After connecting the robot arm cable to the robot controller, hook a fixing latch, so that the 

cable does not slip out.  
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Connecting the power supply to the robot controller 

Connect the power cable approved in your country to the power terminal. Robot controller's 

power terminal accepts standard IEC plugs.  

 

The minimum requirements for power supply are ground, main fuses and circuit breakers, and 

they should be prepared by the person who prepares for installation. 

The following electrical specifications are applicable to power supplies.  

Input power 100 ~ 240 VAC 

External power supply fuse 8 ~ 16 A (100 ~ 240 V) 

Input frequency 50 ~ 60 Hz 

 

 Caution 

While the robot is on, do not remove the robot connector, the power connector or the 

teaching pendant connector. When connecting teaching pendant to controller, pay attention 

to the pin of the connector. 
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3.6 Fixing the Controller Box 

The controller box can be fixed to the ground by using the fixing bracket at the bottom. Fix it 

with M14 bolts not shorter than 45 mm in combination with flat washers. 

 

 

Note Bolts or screws fixing the controller box are not included in the product package. 
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3.7 Overview of Controller I/O 

If you want to connect other external equipment to your controller, then you must first connect 

it to the I/O inside the controller box. The controller I/O is very flexible, so it can be connected 

to various equipment such as relays, PLC, and emergency stop buttons. 

The following electrical interface layout exists for the area inside the controller box. 

 

 

 

 Caution 

To connect the I/O wiring, first turn off the controller and connect the wiring to the I/O 

connector. Product damage caused by the user’s negligence, e.g. incorrect wiring or 24 V 

power short, is not covered by the warranty. 
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3.8 Common Spec for Digital I/O 

The section defines the electrical specifications of the following 24V digital I/O for the 

controller box. 

 Safety Input: 4 EA 

 Flexible I/O: Input 8 EA, Output 8 EA 

 General I/O (Digital I/O): Input 8 EA, Output 8 EA 

By implementing the terminal block called IO Power (J8), you can supply power to the digital 

I/O from an internal 24V power supply or external power supply. The left two blocks are 

composed of internal 24V(INT_24V), GND and the right two blocks are composed of external 

24V(EXT_24V), GND. They can supply power from the outside to the digital I/O.  

Basically, internal 24V power is supplied for use. The basic power supply configuration is as 

follows. 

 

INV Internal 24 V I/O power supply Current limit: 2 A 

Typ. DC 24 V 

Min. DC 23 V 

Max. DC 26 V 

ING Internal 24 V I/O GND 

EXV External 24 V I/O power supply 

EXG External 24 V I/O GND 

If the digital I/O power supply provided from the inside of the controller is not sufficient, then 

you can connect an additional power supply externally. If an internal/external power supply is 

used, then the current limit of 2A is applied. 

If the digital I/O requires more current, then you can connect an external power supply as 

follows. 
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Note If the current is over the upper limit, then the digital I/O fuse can blow off. If the 

fuse is blown off, you need to replace it. 

 

You can configure the terminal block called as Power Switch (J9) to use it as an external power 

supply switch. 

 

SW+ Push Button Input 

SW+ Push Button Input 

SW- GND 

SW- GND 

 

The following electrical specifications apply to the internal or external power supply. 

Terminal Parameter Minimum Format Maximum Unit 

Internal 24V power supply 

INT – ING 
Voltage 23 24 25 V 

Current 0 - 2 A 

External 24V requirements 

EXV – EXG 
Voltage 20 24 29 V 

Current 0 - 2 A 
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The digital I/O is manufactured by complying with the IEC 61131-2 standard. The following 

electrical specifications apply. 

Terminal Parameter Minimum Format Maximum Unit 

Digital output 

FOx / DOx  Current 0 - 0.2 A 

FOx / DOx Voltage drop 0 - 0.5 V 

FOx / DOx Leakage current 0 - 0.1 mA 

FOx / DOx Functions - PNP - Format 

FOx / DOx IEC 61131-2 - 1A - Format 

Digital input 

EIx/SIx/FIx/DIx Voltage  -  V 

EIx/SIx/FIx/DIx OFF area  -  V 

EIx/SIx/FIx/DIx ON area  -  V 

EIx/SIx/FIx/DIx Current (11-30V)  -  mV 

EIx/SIx/FIx/DIx Functions - PNP - Format 

EIx/SIx/FIx/DIx IEC 61131-2 - 3 - Format 
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3.9 Configuring the Safety Input 

Since a single signal loss should not lead to a loss of the safety function, all the I/O's related to 

the safety should be duplexed.  

Safety Input should always comply with the common specs of the digital I/O. When you install 

the safety device or equipment, you should comply with the instructions from Chapter 2 Safety 

and Chapter 3 Installation. 

Safety inputs include emergency stop and safety protection stop. Emergency stop input is for 

emergency stopping of the robot and safety protection stop input is for protection of all the 

safety classes. Their functions are different from each other in this sense. 

 Emergency Stop Safety protection stop 

Robot stops the movement Example Example 

Run the program Stop Pause 

Robot power Off On 

Initialization Manual Auto or manual 

Frequency of use Low Mid 

Re-initialization required Break release only No 

Stop category (IEC 60204) 1 2 

Performance level (ISO 13849-1) PLd PLd 

Using the Flexible I/O, you can set the Safety I/O additionally. For example, you can use the 

emergency stop output. In addition, you can configure the Flexible I/O for the safety function in 

the GUI. 

 Danger 

Do not connect safety signals to normal PLCs. Only safety PLCs must be connected to safety 

signals. If you do not comply with the warning, then the safety stop function may fail, 

causing severe injury or even death. The safety signal and the general I/O signal should be 

separated from each other. 
 

 Warning 

 All the safety class I/O's are duplexed. By separating the channels, you should 

make sure the safety function is not initiated by a signal failure. 

 Before installing the robot, you must check the safety functions. In addition, the 

function should be checked for defects periodically. 
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Initial safety configuration 

The safety settings of the robot at the factory are as follows. 

 Operation software: Unassigned 

 Robot controller(Emergency connector): As shown below 

 

Connecting the emergency stop button 

It is recommended that you connect one or more emergency stop button. The emergency stop 

button is composed as follows. 

 

  



Chapter 3 Installation 

59 

Safety protection stop and restart 

As an example of basic safety protection device, basically, when the door opens, you can press 

the door switch to stop the robot. You can configure the function as follows. 

 

 

 

If you cannot close the door after a worker passed through it, then you can use the following 

features. As another way to resume robot operation, you can use the safety mat or the safety 

class laser scanner.  
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3.10 Configuring the General Digital I/O 

If not used as a safety function, then you can use the Flexible I/O as a general purpose digital 

I/O. 

The general digital I/O should comply with the common specifications of digital I/O. 

The general digital I/O can be used to configure relays or PLC systems. In this configuration, if 

the program is not running, the output is maintained low at all times.  

Load control with digital outputs 

You can control loads with digital outputs. You can configure it as follows. 

 

Digital input control using buttons 

You can connect a simple button to a digital input. You can configure it as follows. 
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Communicating with other equipment or PLC 

The digital I/O can be configured to communicate with other equipment if a common GND is 

established and if the equipment uses PNP technology. You can configure it as follows. 
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3.11 Configuring the General Analog I/O 

It can be used to set or measure voltage (0-10V) or current (4-20mA) between two equipment. 

For high reliability, it is recommended that you use the following method. 

 Use the analog ground closes to the I/O. 

 Equipment and control box should share the same ground. Analog I/O is not insulated in the 

control box. 

 Use the cable that is shielded or twist paired. Connect it to the ground shield of the power 

(J12) terminal. 

 The current signal is not sensitive to noise, so simply use an equipment operating in current 

mode. 

The input mode can be set in the GUI. The following electrical specifications apply to the I/O. 

Terminal Parameter Minimum Format Maximum Unit 

Current mode input 

AIx – A0V Current 4 - 20 mA 

AIx – A0V Resistance - 20 - Ohm 

AIx – A0V Resolution - 12 - Beat 

Voltage mode input 

AIx – A0V Current 0 - 10 V 

AIx – A0V Resistance - 12 - Kohm 

AIx – A0V Resolution - 12 - Beat 

Current mode output 

AOx - A0V Current 4 - 20 mA 

AOx - A0V Resistance 0 - 10 V 

AOx - A0V Resolution - 12 - Beat 

Voltage mode output 

AOx - A0V Voltage 0 - 10 V 

AOx - A0V Current -20 - 20 mA 

AOx - A0V Resistance - 1 - ohm 

AOx - A0V Resolution - 12 - Beat 
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Analog output 

You can use analog outputs as speed control inputs to the conveyor belt. You can configure it as 

follows. 

 

 

Analog input 

You can use analog sensor outputs as analog inputs. You can configure it as follows. 
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Chapter 4  Getting Started 

4.1 Turning on the Robot Controller 

Turn on the power switch at the bottom of the controller. If you turn on the power switch for 

the controller, power will be supplied to the controller. 
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4.2 Turning on the Teaching Pendant 

Turn on the power button at the left top of the teaching pendant. 

 

 

 

 Caution 

 Do not turn on the teaching pendant with USB devices connected. It may cause 

problems with starting the system. Connect it after the system is booted completely. 

 Do not unnecessarily touch the screen while booting the system. It may cause problems 

with starting the system. 
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Chapter 5  Software Overview 

5.1 Menu Overview 

Expanding menu 

Press the expanding menu button at the left top of the screen to expand the menu. 

You can check the name of each menu and if a sub menu exists, then you can select 

it as well. 

                 

Robot Operation 

 

You can configure basic operation / control (start, pause) of your robot. 

For more details, refer to Chapter 10 Starting the Robot.  

Programming 

 

You can configure the robot's movements. 

For more details, refer to Chapter 9 Programming.  
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Monitoring 

 

You can check the real time condition of the robot arm. 

For more details, refer to Chapter 11 Monitoring. 

Robot Setting 

 

You can configure the installation information before operating the 

robot. For more details, refer to Chapter 7 Setting Robots. 

Safety Setting 

 

You can configure the safety items before operating the robot safely. 

For more details, refer to Chapter 8 Safety Settings. 

Device Setting 

 

You can configure an external equipment that will be linked to the robot. 

For more details, refer to Chapter 12 Linking with External Equipment.  

Management 

 

You can register a robot or user and manage logs, etc. 

For more details, refer to Chapter 6 Registering Robots and Users, 15.4 

Viewing and Managing Logs & 15.4 Viewing and Managing Logs. 

SW Configuration 

 

You can configure the operation software environment. 

For more details, refer to Chapter 13 Environment Setting. 

Message 

 

You can select whether or not to display the message window that shows 

messages that have been set while the robot program is running.  
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Manual Move 

 

You can control the robot manually. 

For more details, refer to 5.3 Manual Move Screen. 

5.2 3D Preview Screen 

The system provides a screen where you can preview the robot's movement or coordinates in 3D. 

You can drag on the screen in the desired direction to change the screen perspectives. 

 

Screen display setting button 

You can configure the information displayed on the preview screen and the screen layout. 

Basic setting button 

 
Hide or unhide the TCP coordinates. 

 
Initialize the size of the preview screen. 

 
Decrease the size of the preview screen. (Level 10) 

 
Increase the size of the preview screen. (Level 10) 

 
Unhide the additional setting button. 

 
Hide the additional setting button. 
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Additional setting button 

 
Hide or unhide the point of the movement path for the tool currently programmed. 

 
Hide or unhide the location/direction of the TCP currently set for the robot. 

 
Hide or unhide the movement path currently programmed. 

 
Hide or unhide the safety borders currently set for the robot. 

 

Note Depending on the purpose of the menu, some buttons are not available in the 

preview screen. 

 

Robot task control button 

You can preview the programmed robot tasks. 

 

Start the program from the beginning or at the selected task. 

When you press the Start button, it changes to the Pause button. 

 

Pause the running program. 

When you press the Pause button, it changes to the Start button again. 

 

Execute the unit command that are currently selected. 

When done, it is automatically selected with the next command. 

 
Terminate an ongoing task. 

 

Note Depending on the purpose of the menu, some buttons are not available in the 

preview screen. 
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5.3 Manual Move Screen 

On this screen, you can control the robot's positions. By using jog control or direct teaching, 

you can control the robot's position. 

Press the  Manual Move button in the main menu. 

 

 Coordinate System: Selects Coordinate System for manual move. (Base, View, TCP) 

 Tool Position: Displays the coordinates of TCP.   

 Joint Position: Displays the angle of the joints. You can modify it by entering a specific 

angle. 

 Rotation: Rotates the TCP by using jog buttons. 

 Direct Teaching: If you manually adjust the robotic arm as you press this button, the 

system detects any changes in the joint position. When the Manual Control of Robot screen 

is accessed, the payload of current TCP is displayed for 3 seconds. If the joint range is 

exceeded during direct teaching, the LED color of tool flange will turn pink. 

 Home: Shifts the robot to its initial position. It works only if the button is pressed. 

 Speed: Adjusts the movement speed of the robotic arm when you control the robotic arm 

manually. 

 Inching: You can set the robot to move in increments of a certain distance or angle.  

- Default: 5mm, 5degree 

- Moving Range : 0.01~10 mm 

- Rotating Range : 0.01~ 10degree 

Note Depending on the purpose of the menu that uses the manual robot control 

function, the screen layout may differ accordingly. 
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If you press the coordinate value on the screen, the screen will be changed as follows, and then 

you can enter the coordinates and the joint angles on your own. 

  

 Press the Input reset button to reset the coordinates and joints’ angles you input to the 

current coordinate of the robot. 

 Press the Move button to move the robot arm to the preset position according to the Move 

type. 

 

 Warning 

When controlling the robot manually, check that there is no obstacle or person around the 

robot before operating it. 

To activate/deactivate the direct teaching function, first make sure the robot is not moving. If 

you activate/deactivate the function while the robot is moving, the robot may malfunction. 

 

 Caution 

 When using the direct teaching function, check that the center of gravity of the TCP 

payload is correctly entered. Entering an incorrect value may cause malfunction. 

 If you drive a joint beyond a certain speed while using the direct teaching function, it 

may make a noise and make an emergency stop for the safety of operators. 
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5.4 Virtual Keypad 

The operation software accepts touch based inputs, so you can use a virtual keypad on the 

screen. Depending on the input types, there are three types of virtual keypads as follows. 

Text keypad 

You can enter or edit simple English texts or special characters. You can use the Shift key to 

toggle between uppercase/lowercase. 

 

 If you want to display your inputted text, press the Accept key.  

 If you want to delete the entire inputted text string, press the  button. 

 If you want to close the keypad, then press the  button at the right top. 

 

Note The Accept key is deactivated and cannot be used if there is no inputted text 

string. 

Number keypad 

You can enter or edit simple numbers. 

 

 If you want to display your inputted numbers, press the Enter key.  
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 If you want to delete the entire inputted text string, press the  button. 

 If you want to close the keypad, then press the  button at the right top. 

 

Note The Enter key is deactivated and cannot be used if there is no inputted text 

string. 

Expression keypad 

You can enter or edit simple expression. 

 

 Basically, an expression is composed of  three input items. 

- Green input field: You can enter fixed variables and numbers.  

- Orange input field: You can enter an arithmetic operator. 

 Add an expression: Select a green input field and press the Add button. The selected green 

input items will be changed to the three basic input items and added into the parenthesis. 
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 Delete an expression: After selecting any item in the parenthesis, press the Delete button. 

The basic input item added into the parenthesis will be deleted. 

 

 If you want to delete the selected input item, then press the Clear key. 

 If you want to display the inputted expression, press the Enter key.  

 If you want to close the keypad, then press the  button at the right top. 

 Clicking the script mode  button allows you to enter a free-form equation, such as a 

script. If this mode is selected, a list of functions available in the script is displayed. 

 

 





Chapter 6 Registering Robots and Users 

77 

Chapter 6  Registering Robots and Users 

After installing the robot, turn on the system for the first time. Only the Management menu 

will be seen. If there is no robot registered, other menus will not be seen.  

6.1 Managing Robots 

You can register a new robot to be linked to the controller or change the robot name. 

In the main menu, select  Management > Robot. 
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Registering robots 

1. Press the Add button. 

2. Add a robot and press the OK button. 

 

3. Enter the robot name and press the Apply button. 

4. When the restart confirmation window appears, press the OK button. 

 You must restart the system for normal operation.  

 

Modifying the robot name 

1. After pressing the text box having the robot name, modify it as you want. 

 

2. Press the Apply button. 
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Registering Force Torque Sensor 

1. Click the Add button on the registered Robot screen.  

 

2. Select the Sensor. It only supports ATI Axia80 at the moment.  

 

3. Press the OK button. 
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6.2 Managing Users 

You can make sure only specific users can use the software by registering them. Also, you can 

grant an individual right to each user to limit their access to the menus.  

In the main menu, select  Management > User. 

 

 

Adding users and setting authorities 

1. Press the Add button. 

2. Set the user information and their authorities and press the OK button. 

 

 The length of text that can be inputted is limited as follows. 

- Name:  25 letters 

- ID/Password: 20 letters 
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 You can choose one of the following two authorities. 

- Admin: Can use all the functions of the software. 

- Operation: Cannot use the safety and the critical setting functions. Settings can be all 

inquired about. 

 

Note  If you are an operation user who lost the password, ask the admin user. The 

admin user can modify the password for an operation user. 

 If the admin user's password is lost, then contact local distributor. 
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Menu available to each authority 

Depending on the authority set in User Management, the following menus become available. 

Even if you are not logged in, you can still use some menus. 

Main menu Sub menu Admin Operator Log Off 

Robot Operation O O O 

Programming O O X 

Monitoring 

Robot Status O O O 

I/O Status O O O 

Utilization O O O 

Robot Setting 

TCP Setup O O X 

Mounting O X X 

I/O Setup O O X 

Coordinate O O X 

Global Variables O O X 

I/O Bit Operation O O X 

Safety Setting 

Motion Limit O △ X 

Safety I/O O △ X 

Safety Boundary O △ X 

Safe Guard  O △ X 

Device Setting 
MODBUS TCP O O X 

Vision System O O X 

Management 

User Management O △ X 

Robot Management O O X 

Log O O X 

Setting Management O O X 

SW Configuration 

General O O X 

Network O O O 

SW update O O X 

Shutdown O O X 

Zeroing Robot X X X 

 

Note  The Zeroing Robot menu is only accessible by the Super Admin user. 

 If you need assistance with zeroing, contact the manufacturer or a local 

distributor. 
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6.3 Login/Logout 

Logging in 

While logged off, the  icon is displayed at the right top of the screen. After finishing 

registering a user, while logged off, press the  icon and enter your ID/password and press the 

Login button. 

 

 

Logging out 

While logged in, the  icon is displayed at the right top of the screen. While logged in, press the 

 icon and press the Logout button. 
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6.4 Checking Status 

Checking Robot Status 

You can check the status of the robot through the robot icon  next to the robot name and the 

status icon  in the upper right of the screen. 

 Green : Servo On 

 Red : Servo Off 

Checking errors 

You can check errors that occur while the robot is in operation or being programmed when 

error status is shown by the  status icon on the top right of the screen.  

 Red number: Shows the number of errors that occurred 

When you click the icon, an error message is displayed, as shown in the figure below. The error 

message shows the error title, error details, error target, and error time. 
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Checking the software version 

You can check the current version of the operating software and control software by clicking 

the  information display icon at the top of the screen. 

 

 Operating software: Displays the operating software version. 
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Chapter 7  Setting Robots 

7.1 Setting the Robot Installation Angles 

After installing a robot, you must set the robot installation angle. 

The purpose of this process is to make sure that actual operation of the robot arm looks same as 

what we saw in the preview screen and let the controller know the direction of gravity. 

 Warning 

The system is unable to automatically recognize the tilt of the ground where the robot arm's 

base is installed and the working range, so before operating the robot, you must enter 

accurate inputs depending on the installation type. 

In the main menu, select the  Robot Setting > Mounting menu. 
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1. Depending on the tilt of the ground where the robot arm's base is installed, set the angle 

accordingly. 

 If installed on the ground, then press 0°, if installed on the wall, press 90°, or if installed 

on the ceiling, press 180° to set the tilt value more quickly. 

 

 

Note The HCR-12 can only be set to either 0° or 180° 

 

 You can touch the gauge or press the left/right   buttons to fine tune the tilt for the 

X/Y axis. 

 

 You can touch the input window to enter the angle value directly. 

 

2. Press the Apply button to apply the settings to the system. 

 Press the Cancel button to revert to the previous settings. 
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7.2 Setting TCP 

When you mount a tool in the robot arm for the first time, you must also set the TCP (Tool 

Center Point). By setting the tip location/direction and the weight of the mounted tool, you can 

calculate the robot's motion.  

You can set a different TCP for each of multiple robots linked, and if you want to use multiple 

tools for a single robot, then you can save different settings and retrieve and apply them to a 

newly replaced tool. 

To set the TCP, in the main menu, select  Robot Setting > TCP Setup. 

 Warning 

If the TCP profile is incorrectly entered, accidents such as collision and jamming may occur 

while operating the robot and the robot may operate incorrectly while using the direct 

teaching function. In addition, as the singularity of the robot arm may vary depending on the 

TCP, the program previously prepared may not work or the robot arm may not operate as 

expected.  Make sure to enter the correct value according to the TCP type before operating the 

robot. 

 

Creating a new TCP profile 

1. Press the Add button. 

 

2. Enter the new TCP name and press the OK button. 

 You may enter up to 25 characters. Special characters other than '-' and '_' are not 

allowed. 
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3. Enter the TCP information. 

 

 Position: Enter the coordinate values (X, Y, Z) with respect to the center of the cross 

section of the location where a tool is mounted. The unit is in mm. 

 Orientation: Set the tool direction (Rx, Ry, Rz). 

 Center of Gravity: Set the center of weight for a tool. 

- Check the checkbox to enable the option. 

- If you do not use the option, all the values are set to zero.  

- Min:-700, max: 700, The unit is in mm. 

 Tool Length: Indicates the tool length. 

- The tool length is automatically calculated but users cannot enter it on their own. 

 Payload: Set the tool weight. 

- If not specified, it will not be saved and an error message will appear. 

 

4. Press the Save button. 

 If successfully saved, then the Set Active TCP button is activated. 

5. If you want to apply the newly set TCP profile to the robot, press the Set Active TCP 

button. 

 The robot will receive the currently selected TCP profile setting values. 

Note  If no TCP is set in the robot, then the “Empty” TCP is set by default. 

 Default settings for Empty TCP: Position (0,0,0); Orientation (0,0,0); 

Center of Gravity (0,0,0) with the Use check box cleared. 
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Calculating the TCP position 

By using the direct teaching function, you can calculate the position of TCP. 

To calculate the position of TCP accurately, receive the position data from various angles with 

respect to one point and analyze them. 

 

After moving a tool to face a certain point at P1, enter the position data. After that, move to an 

arbitrary point, P2 and let it face the same point and enter the position data. Proceed this way 

until you have at least three points. The angle between each point (A, B) should be at least 10°. 

Note  A tool is not included in the product package. 

 The TCP location may not be calculated correctly depending on the tool shape 

or the TCP movement. 

 Since only the TCP location is calculated, you should enter the weight and the 

center of gravity of the tool before direct teaching. 
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To calculate the position of TCP, proceed as follows. 

1. After pressing the Edit button, press the Position button. 

 

 

2. Press the Teaching button. 
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3. Press the P1 button when it is activated. 

 If you press the P1 button, the Manual Move screen will appear.  

 

4. While pressing down the Direct Teaching button in the Manual Move screen, move 

the robot arm to place the tip of the tool right at the reference point. 

 For more descriptions on the Manual Move screen, refer to 5.3 Manual Move Screen. 

 

5. In the Manual Move screen, press the OK button. 

6. When the P2 button is activated, repeat steps 3 through 5. 

 An error will occur if the previously inputted coordinate and the currently inputted 

coordinate do no differ by more than 10°. The point button with errors will be marked in 

red. If an error occurs, then you need to change and reset the angle for that point. 

 

 The more the point data is, the more accurate the calculation result becomes. You can set 

the maximum 10 points. 
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7. Press the Calculate button. 

 The Calculate button will be activated only if the minimum three points are set 

properly. 

 

8. Check the calculated position result and press the Apply button. 

 Press the Cancel button to cancel the task. 

 

 

Setting the TCP orientation 

You can calculate the orientation of the tool in the tool coordinate system automatically. 

1. Press the Edit button and press the Orientation button. 
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2. Press the Set Orientation button.  

 If you press the Set Orientation button, the Manual Move screen will appear. 

 

3. In the Manual Move screen, use jog control and Direct Teaching button to adjust the 

tool orientation as follows. 

 For more details on the Manual Move screen, refer to 5.3 Manual Move Screen. 

 As shown in the figure below, let the Z, -X, and Y axes for the tool face the same 

direction as the X, Z, and Y axes for the robot base respectively. 

 

4. In the Manual Move screen, press the OK button. 

5. Press the Apply button to apply the settings to the system. 

 Press the Cancel button to cancel the task.  
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Changing the TCP profile name 

1. Select the TCP setting profile to modify. 

 

2. Press the Edit button. 

3. Press the Rename button. 

4. Enter the desired name and press the OK button. 

 You can enter the max 25 letters but cannot use special characters. 

5. Press the Save button. 

Editing the TCP profile 

After checking the name of TCP profile currently used by the selected robot, and proceed as 

follows.  

1. Select the TCP profile to edit. 

2. Press the Edit button. 

 You cannot edit the TCP profile currently being used by another robot. 

 You cannot edit an empty profile. 

 While you are editing it, the Set Active TCP button is deactivated. 

3. When you are finished with modifications, press the Save button. 

 When you are finished with saving, the Set Active TCP button is activated. 

 If you want to revert the modified settings to the previous setting, then press the Cancel 
button. 

Deleting the TCP profile 

After checking the name of TCP profile currently used by the selected robot, and proceed as 

follows. 

1. Select the TCP profile to modify. 

2. Press the Delete button. 

 You cannot delete the TCP profile currently being used by another robot. 

 You cannot delete an empty profile. 

3. Press the OK button.  
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7.3 Setting Inputs/Outputs 

By changing the name of I/O used by the controller, you can make sure they are easily detected 

and also assign a function to be executed depending on the input/output signals. 

In the main menu, select  Robot Setting > I/O Setup. 

 

Types of digital I/O 

There are four types of digital I/O as follows. 

 Redundant I/O: Input and output with duplexed connections for the safety purposes. 

 General I/O: Input and output for general purposes. 

 Tool I/O: Input and output related to tools.  

 SafeGuard I/O: Input of Safeguard Stop. 
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Editing the digital inputs settings 

Press the Edit  icon for the digital I/O item to modify. The following edit window will 

appear. 

 

 Name: Use a name easy for a user to identify or the existing name. 

- You cannot use the same name already in use by another I/O. 

- Max 15 letters (30 bytes) are allowed. Special characters cannot be used. 

 Command: Set the command to be executed when the preset value (Low/High) is 

inputted or outputted to the I/O terminal. 

- Unassigned: The I/O is not used. 

- Program Play: Start the program. 

- Program Stop: Stop the program. 

- Program Pause: Pause the program. 

- DirectTeaching Mode: Switch Robot to Direct Teaching Mode. 

 

Note You can only change the name, if it is a redundant I/O. 

Editing the digital outputs settings 

Press the Edit  icon for the digital I/O item to modify. The following edit window will 

appear. 

 

 Name: Use a name easy for a user to identify or the existing name. 

- You cannot use the same name already in use by another I/O. 
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- Max 15 letters (30 bytes) are allowed. Special characters cannot be used. 

 Command: When the robot is in the state of the set command, the value set(Low/High) 

to the output terminal is output. 

- Unassigned: The I/O is not used. 

- Program Running: Outputs the set value when the program is executed. 

- Program Stopped: Outputs the set value when the program stops. 

- Program Runtime Error: Outputs the set value when error occurs. 

Note You can only change the name, if it is a redundant I/O. 

 

Types of analog I/O 

There are three types of analog I/O as follows. 

 General I/O: Input and output for general purposes. 

 Tool I/O: Input and output related to tools. 
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Editing the analog I/O setting 

Press the Edit  icon of the analog input or output item to modify and the editing window 

will appear as follows: 

 

 Name: Use a name easy for a user to identify or change the existing name. 

- You cannot use the same name already in use by another I/O. 

- Max 15 letters (30 bytes) are allowed. Special characters cannot be used. 

Note For analog I/O, you can only change its name. 
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7.4 Coordinates  

You can set the location information that is available in the program and other setup menus.  

From the main menu, select  Robot Settings > coordinates. 

 

 Point: Add a point.  

 Line: Add a line consisting of two points. 

 Plane: Add a plane consisting of 3 points. 

 Coordinates generated by a point, a line, and a plane are available when you a variable is 

selected.  

 Points consisting of each of them are available when Enable is selected.  

 When you select the name of a point, the input tool that allows you to edit is displayed. (Up 

to 25 characters) 
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Registering points 

You can add and set point coordinates.  

 The position where the point coordinates are set becomes the reference position, and the 

coordinate system is set to the same coordinate system in which TCP was set.  

 

Registering line coordinates 

You can add and set line coordinates.  

 Click point 1 and point 2 to set two points to define a line.   

 Coordinate system information  

- Reference point: The first point becomes the reference point.  

- Y axis: The direction of the first point to the second point is the Y axis.  

- Z axis: This becomes the robot's Z axis.  

- X axis: This is set to the other axis.  
 

Registering plane coordinates 

You can add and set plane coordinates.  

 To define a plane, set point 1, point 2, and point 3 in sequence.  

 Coordinate system information  

- Reference point: The first point becomes the reference point.  

- Y axis: The direction of the first point to the second point is the Y axis.  

- Z axis: Select the Z axis using the right-hand rule in three rotation directions together 

with the third point.    

- X axis: This is set to the other axis. 
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7.5 Setting Global Variables 

You can set the global variables that are available and shared by many programs by restarting 

the system.  

 

Adding global variables 

When you press the Add button, a screen for variable selection window is displayed at the top, 

as shown below. 

 

 Number : Variables to store numbers 

 String : Variables to store string 

 Boolean : Variables of True or False type 

 Position : The Position of TCP 

 Joint : The Values of Joints 

 Array : Array type variables 

If you select a variable type, the variable is automatically entered with the default name. 
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Modifying global variables 

1. Press the field if you need to change the variable name or value. 

 

2. Change it to the desired name or value and press the OK button. 

 The max length of variable is limited to 10 letters. 

 For a variable value, you can only enter a number. The range is from -2147483647 

to 2147483647. 

 Character variable’s maximum length: 20 characters 

 

Deleting global variables 

1. Check the checkbox for the variable to delete. 

2. Press the Delete button and press the OK button. 
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7.6 I/O Bit Operation 

You can combine the values of multiple digital I/O inputs, and assign them to variables or 

assign them to actions.  

  

Add/Delete 

Add or delete bit operation settings.  

 Clicking the Add button adds one setting, and the initial value of each IO is displayed as 

Low.  

 The Delete button is enabled when any check box in a row is selected. If it is clicked, the 

selected row will be deleted.  

 Settings cannot be added while the program is running or started.  

I/O bit operation settings 

Set I/O bit operation value and assign a function.  

 Each time you click the I/O bit icon, it changes, through a sequence of Low/High/Disable.  

 High is assigned to 1, Low is assigned to 0, and the bit operated value is displayed in the 

value field.  

 The IO of the bit set to Disable is treated as '0' regardless of the actual value received.  
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Chapter 8  Safety Settings  

After configuring the installation settings, you must configure the safety settings to protect users 

against the dangerous situation that can arise during robot operation. 

 Warning 

Make sure to check safety settings immediately after the robot is installed. In addition, all of 

the functions for safety settings must be regularly checked. 

8.1 Limiting Robot Movement 

To guarantee the user's safety while interacting with the robot, you can make sure that the angle 

and speed of robot joint does not exceed a certain limit. 

Press  Safety Setting > Motion Limit in the main menu. 
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Default settings 

Depending on the limitation on each item, four sets of default settings are provided. 

If you want to use the default setting, check Preset and select one out of the four choices. 

 

Manual setting method 

If you want to set each item on your own, you can use the adjustment bar to change the value 

while Preset is not checked. Or, after pressing the input box, you can enter your own inputs. 

 

There are several ways to limit the robot's movement. 

 Torque: You can limit the max force that the robot(TCP) is exerting to the outside. 

 Force: To be determined 

 Speed: You can limit the max speed for the TCP's linear movement. 

 Collision mitigation: This can be set to mitigate the impact of a target object in the event 

of a collision. 

 Deceleration mode speed (%): Sets the speed in deceleration mode. When 

deceleration mode is applied, a red alarm occurs at the top of the screen. Clicking the alarm 

moves you to the initial screen. 

 Joint Rotation: You can limit the angle of each joint. 

 Joint Speed: You can limit the speed of each joint. 

Press the Cancel button to revert the settings newly changed by a user in the current tab 

(general mode or deceleration mode) to the previous value. 

When the settings are complete, press the Apply button to apply it to the robot. 
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 Caution 

 The joint speed cannot be limited with the Speed option. You can limit the joint speed 

only with the options in the Joint Speed tab. 

 If the temperature of the operating environment for the robot arm is not greater than 

10 ℃ during the initial start, collision detection may occur due to the limited force. If 

such problem occurs, increase the limit value of Force sufficiently, operate it at a low 

speed for about 30 to 60 minutes for preheating, and lower the Force value to use it. 

 If you increase the force limit for collision detection to a high value, the user’s risk 

increases. Exercise caution to ensure safety against collision. 
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8.2 Setting Safety Boundaries 

To improve user safety, you can build virtual fences around the robot to prevent the TCP from 

moving beyond the boundary of these virtual fences. 

Press  Safety Setting > Safety Boundary in the main menu. 

 

Adding safety boundary planes 

After adding multiple safety boundary planes, if necessary, you can select one of them and use it. 

1. To add a boundary plane, press the Add  button. 

 If you press the Add  button, the Manual Move screen will appear. 
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2. In the Manual Move screen, use jog control and Direct Teaching button to set the 

boundary position. 

 

 For more details on the Manual Move screen, refer to 5.3 Manual Move Screen. 

 Your safety boundary will be created in a location that is separated from the center axis 

of the flange as much as the TCP length set in the TCP. 

3. To save the settings, press the OK button. 

Viewing safety boundary planes 

Press the icon in the View column to hide or unhide the safety boundary plane in the preview 

screen.  

 

 : To display in the preview screen. 

 : Not to display in the preview screen. 
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Press the Info  icon to check the coordinates for the safety boundary. 

 

 Point: Indicates the center of the 3-D where the center of the safety boundary is located. 

 Direction: Indicates the direction(vector) for the border plane that can indicate a collision 

with the safety border in the controller. (Blue Z-axis on the screen) 

 

Applying safety boundaries 

1. Activate the boundary for use. 

 

 : To use 

 : Not to use 

2. Press the Apply button. 

 Press the Cancel button to cancel the modifications and revert to the previous settings. 

 

Note If there are eight or more safety boundary planes in the list, press the up/ down 

 button to scroll. 
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Changing the name of safety boundaries 

If you add a safety boundary, it will save as "Boundary" and a number by default.  

1. Press the name of boundary to modify. 

 

2. Enter the desired name and press the OK button. 

 

Deleting safety boundary settings 

1. Select the safety boundary to delete. 

 

2. Press the Delete  button. 
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3. Press the OK button. 

Note If the robot arm moves outside the safety boundary plane during operation or the 

robot arm is located outside the safety boundary plane due to the safety boundary 

plane settings, disable Safety Setting, use the manual control mode to move the 

robot arm to within the safety boundary plane, and then operate the program. 
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8.3 Setting Tool Boundaries  

The user sets the safety boundary of the set tool, so that the tool does not go beyond the safety 

boundary of the set working area.  

 

Adding Tool Safety Boundary Surfaces 

The safety boundary of the tool can be set only for TCP settings that have already been set. 

1. Select the Tool Boundary tab and select an item with the name of the TCP you want to set 

from the list. 

2. When you set the selected TCP to Use, a box-shaped tool safety boundary is created on the 

screen by default. 

 

  



Chapter 8 Safety Settings 

116 

3. The tool boundary surfaces can be set in the following 4 types: 

       

 Box:  Box-shaped boundary surface with TCP as the center having the Z axis of the 

TCP as the height and the X axis as the width 

 Sphere: Spherical boundary surface with constant radius and with TCP as the center  

 Cylinder: Cylindrical boundary surface with TCP as the center, having a height in the 

Z-axis of TCP 

 Cone: Cone-shaped boundary surface with TCP as the center, having a height and 

direction in the Z-axis of TCP  

For 
reference 

The TCP currently applied to the robot is marked with the . 

Each boundary surface of the tool has the same coordinate axes as TCP's 

coordinate axes. 

Setting Tool Safety Boundary Surfaces 

1. The boundary surfaces of the tool set to Use are set to a box by default. The user selects one 

of the four boundaries for the shape of the tool or the desired shape. 

2. The selected boundaries are displayed on the screen, and the radius, height, width, etc. are set 

according to the selected form. In addition, you can move and set them based on the TCP 

coordinates, and enter the rotation angle along the coordinate axis. 

 

Applying Tool Safety Boundary Surfaces 

1. Switch the boundary surface you want to set to the TCP to Use or Not Use. 

2. Press the Apply button. 

 Press the Cancel button to cancel the current settings and return to the previous setting. 

Note Pressing the Apply/Cancel buttons simultaneously applies the safety 
boundary of the working area to the safety boundary of the tool. 
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8.4 Setting Redundant I/O 

To guarantee the safety of the I/O terminal or input/output the important data, you can opt for 

using a redundant I/O, not a single I/O.  If you set the redundant I/O, you are no longer 

checking a single I/O value. Instead, the two designated inputs or outputs check the High or 

Low signals to determine validity of values. 

In the main menu, press  Safety Setting > Redundant I/O. 

 

There are two tabs - digital input and digital output. Select the tab to set and proceed as 

follows. 

 In case of digital inputs, the function will operate if the input is high or low. 

 In case of digital outputs, the high or low signal is sent for the assigned function. 

1. Press the Add button. 

2. Select an I/O terminal to be used as redundant I/O.  

3. Set the function to be assigned. 

 You can assign the following functions to digital inputs. 

- Unassigned: The function is not assigned. 

- Reduced Speed: Reduce Robot Speed. 

 You can assign the following functions to digital outputs. 

- Unassigned: The function is not assigned. 
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- Emergency Stop: If the two designated IOs are in the emergency stop state, Low (0) is 

output. Otherwise, High (1) is output. When a physical emergency stop button is pressed, 

it operates even when the designated IO is in the emergency stop state. 

- Robot Moving: If the robot moves, the designated output terminal outputs Low (0). 

Otherwise, it outputs High (1). 

- Robot Not Stopping: The designated output terminal outputs High (1) till the time 

point when the stop command is performed after the stop command is ordered to the 

robot. Otherwise it outputs Low (0). 

4. Press the Apply button. 

 Press the Cancel button to revert to the previous settings. 

 

Note User can name each I/O on their own. For more details, refer to 7.3 Setting 
Inputs/Outputs. 
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8.5 Setting Safeguard I/O 

The user sets the safeguard stop.  

In the main menu, press  Safety Setting > Safe Guard. 

 

 

 Assign a Safeguard Stop function with the IO. 

 Click Apply button to apply to the system. 
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8.6 Exceeding Safety Limit of Joints 

If the safety limit of any joint is exceeded, information on the joint exceeding the safety limit is 

displayed at the top of the screen, as shown in the figure below.  

 

If the safety limit of a joint is exceeded, the system will not operate normally. Therefore, the 

operating range must be safely set to the normal range, through the following procedure. 

1. Go to the administration screen by selecting the administration menu or clicking the top 

guidance message. 

2. Uncheck 'Use Safe Settings.' 

3. Click the 'Reset' button to perform a reset, then click the 'Start' button. 

4. Click Manual Manipulation at the bottom left to go to the manual control screen. 

5. Joints that exceed the safety limit are controlled to be within the normal range by using the 

jog button. 

6. If they are within the normal range, return to the operating screen. 

7. Check 'Use Safe Settings'.  
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Chapter 9  Programming 

You need to program the movement ahead of time if you want your robot to perform a certain 

task. 

To program your robot, select  Programming in the main menu. 

9.1 How to Use Commands 

Selecting a flowchart 

There are two types of flow charts - main and sub. 

 

 Main Program: In this screen, you can input or modify the main program. 

 Sub Program: In the main program, you can call multiple sub programs for use. Press the 

Sub tab to move to the screen where you can create or edit a sub program. For more details 

about the sub program, refer to 9.16 Using a Sub Program. 

 Thread Program: This is a program creation screen that is executed in parallel with the 

main program. 
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Type of commands 

You can use the following commands in your programming - Move, If, Loop, Switch, Halt, 

Wait, Set, Loop, Pattern, Sub Program, and Vision. 

 

 

 
Move 

Set the point that the TCP will move to. 

For more details, refer to 9.7 Move command. 

 
If 

Branch the commands based on the conditions. 

For more details, refer to 9.8 IF Command. 

 
Loop 

Repeat a specific command. 

For more details, refer to 9.9 LOOP Command. 

 
Switch 

Branch the command for each case of the designated variable. 

For more details, refer to 9.10 SWITCH Command. 

 
Wait 

Tell the robot to wait until the condition entered by the user is 

met. For more details, refer to 9.11 Wait Command. 

 
Set 

Create output signals, variables and TCP profile. 

For more details, refer to 9.12 Set Command. 

 

Sub 
Program 

Call a sub program. 

For more details, refer to 9.16 Using a Sub Program. 

 
Variables You can manage the variables required for program creation. 

 
Commands 

Indicates that additional commands can be used in addition to 

the basic commands. 

 
Edit 

Provides editing functions such as copy, cut, paste, delete, and 

move to the icons of the currently created program. 

 

  



Chapter 9 Programming 

123 

Additional Commands 

In addition to the basic commands, the additional commands that appear when the View 

Command button  is clicked are Folder, Message, Halt, Conveyor, Vision, Pattern, Script, 

and Path. 

 

 

 
Folder 

Groups the created program command icons and bundles the 

programs into a sub-folder. 

 
Message Define Message Type. 

 
Halt Terminate the program. 

 
Conveyor Set the operation to be linked with conveyor’s movement.. 

 
Vision 

Use a vision equipment to scan an object. 

For more details, refer to 9.18 Vision Command. 

 
Pattern 

Tell the robot to move according to the predefined pattern. 

For more details, refer to 9.15 PATTERN Command. 

 
Script Provides Editor to edit scripts.  

 
Path 

Enables the user to directly grasp the robot arm and create 

motion in order to generate the motion of the robot.  
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Entering commands 

Each time you press a command, it is inputted in the timeline one by one. 

  

 After programming is complete, select the icon  to repeat the entire program 

continuously.  

 If it overflows to the next screen due to too many commands in the flow line, you can press 

the up/down  or left/right  buttons to scroll. 

 At the start of the program, you can initialize variables, IO, robot posture, etc. using the 

initialization icon . This initialization icon cannot be deleted.  

Check Icon Status 

   Command that do not change any parameter after adding new.  

   Command which value has been modified.  

 When the program is saved, the current icon state is maintained.  

 When clicking the Apply button, all icons are changed to normal state.  

Changing command names 

Each command offers an option necessary for execution. The same command yields a different 

result depending on the option setting, so you can designate a different name for each 

command.  

After entering a command in the timeline, press the command name to modify the name. 
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Deleting commands 

1. Select a command to delete in the timeline. 

2. Press the Delete button. 

 

Searching Commands  

1. Click the Search button to display the search function on the screen. 

 

2. Enter the name of a command to be searched, and perform a search. 

 

3. If there is a searched command, the number of searched commands is displayed, and you can 

easily find the command by using the left/right navigation button. 

 

Skipping Commands  

For each command created in the program, you can skip without executing a specific command 

during program execution.  

1. Check the Skip setting. 

 

2. Commands that have been set to Skip are grayed out, and will not be executed during 

program execution. 
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Tree  

If you click the , all the commands programed are displayed in Tree structure. The 

commands in the Tree and the command icons in the flowchart are displayed in synchronization 

with selection or program progress.  
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9.2 Setting Variables 

You can manage variables such as adding/deleting/modifying variables to be used in the 

program. Press the variable management menu button at the end of the command list.  

 

When you press the variable management button, a screen for variable management and 

monitoring is displayed at the top, as shown below.  

 

Adding variables 

Press the Add button. If you press the Add button, the default name and value (0) will be 

automatically entered. 

 Number : Variables to store numbers 

 String : Variables to store string 

 Boolean : Variables of True or False type 

 Position : The Position of TCP 

 Joint : The Values of Joints 

 Array : Array type variables 

If you select a variable type, the variable is automatically entered with the default name.  
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Modifying variables 

1. Press the field if you need to change the variable name or value. 

2. Change it to the desired name or value and press the OK button. 

 The max length of variable is limited to 10 letters. 

 For a variable value, you can only enter a number. The range is from -2147483647 to 

2147483647. 

 Character variable’s maximum length: 20 characters 

Deleting variables 

1. Check the checkbox for the variable to delete. 

2. Press the Delete button and press the OK button. 

Variable Monitoring 

You can check the number of currently registered global variables and the real-time values of 

variables registered in the robot. Numeric variables are displayed with up to four decimal places, 

rounded to five decimal places. 
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9.3 Editing programs 

If you want to change the order or structure of commands entered in the timeline, then press the 

Edit menu button at the end of the command list. 

 

 

Note You can also press the command in the timeline for more than three seconds to 

open the Edit menu. 

Overview of edit menu 

 

 

 
Cut 

Cut the selected command. You can crop a command to 

another location. 

 
Paste 

Paste the cropped or copied command to the selected 

location. 

 
Copy 

Copy the selected command. You can copy a command 

to another location. 

 
Delete Delete the selected command from the program. 

  

Left or 

Right 
Move the selected command to the left or right in the 

timeline. 

 

Batch 
Apply 

Applies the values of several selected Move commands 

in batches. It is activated when you select the same move 

command.  

 

Combine 
Folder 

Create a folder at the end of the program and move 

selected icons below.  

 

Clear 
Selection 

Cancel the selection of the command. 

 
Close 

Close the program editing mode and return to the 

program screen. 
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Example of program editing 

In this example, you can cut a command entered in the timeline and paste it onto another 

location. 

1. Select a program command to be pasted onto another location. 

 The red number marked when a command is selected indicates the order of pasting. 

 

2. In the edit menu, press the Cut button. 

 After pressing the Cut (or Copy) button, the Select Mode button will be activated, so 

that you can cancel the edit command and return to the Select Mode again. 

 

 

 

3. Select a location to paste it to. 

 Space between commands cannot be selected, so you must select the command right 

before the location of pasting. 

 Once a location is selected, the Paste button in the Edit menu will be activated. 
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4. Press the Paste button. 

 

 

 

Note Commands added using the Copy/Paste buttons are created with the same name.  

To differentiate between coordinates, change the names of the commands. 

 

Undo Function 

  Undo 
You can use the edit function to undo edits made 

to items.  

 
Redo You can redo an edit that has been undone.  

 

Note . Up to 50 steps are saved.  

. The edit history is initialized when you open a New File, File Open or 

Cancel. 
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9.4 Managing a Program 

At the bottom of the programming window, press the File button to save, load or delete the 

program. 

 

Saving a program 

1. To save the completed program, select File > Save at the bottom of the screen. 

2. Enter the program name and press the OK button. 

 Only if the program is newly saved or saved with a new name, the name input window 

will appear. 

If you want to save the program with a different name, press Save as and enter the name and 

then press the Save button. 

Making a new program 

If you want to make a new program, then select File > New at the bottom of the screen. 

Note Enter the program name when you apply or save a program. 

 

  



Chapter 9 Programming 

133 

Loading a program 

1. To load the saved program, select File > Load at the bottom of the screen. 

2. Select a program to load and press the OK button. 

 

Deleting a program 

1. To delete the saved program, select File > Load at the bottom of the screen. 

2. Select a program to delete and press the Delete button. 

 

Export as script 

1. To save the program as a script, select File > Export as script at the bottom of the 

screen. 

2. Enter the file name and press the OK button. 
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Export Program File 

You can save the program and the configuration file of current system 

1. To save the program, select File > Export Program File at the bottom of the screen. 

2. Enter the file name and press the OK button. 
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9.5 Using Templates 

You can save the prepared program structure as a template. Only the entire program structure is 

saved but the option for each command is not saved. 

 

 

Saving as a template 

To save the completed program as a template, select Template > Save at the bottom of the 

screen.  

If you want to save the template with a different name, press Save as and enter the name and 

then press the Save button. 
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Loading a template 

1. To load the saved template, select Template > Load at the bottom of the screen. 

2. Select a template to load and press the OK button. 

 

 

Deleting a template 

1. To delete the saved template, select Template > Load at the bottom of the screen. 

2. Select a template to delete and press the Delete button. 
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9.6 Applying programs 

Before applying the program results to the robot or actually using it, it is necessary to do a 

simulation. 

 

 

If you want to link the program to an actual robot or check it in previews, press the Apply 

button. To revert it to the previous settings before the changes are made, press the Cancel 
button. 

 

 To check it in preview, select Simulation. 

 To link it to a real robot, select Real Robot. 

 The entire program speed can be adjusted by using the Speed slide bar. 
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9.7 Move command 

The command is used to move the robot arm by designating the destination and the movement 

method. 

Selecting a movement method 

There are three ways to move as follows and you can set the tool speed and acceleration for each 

method. 

 Linear: A tool moves linearly between the starting point and the end point. To make the 

tool movement path a straight line, each joint tends to move in a more complex way. 

 Frame: Select whether to move by TCP or Flange.  

 Reference coordinate system: Select the reference coordinate system on which the 

robot moves when executing the move command.  

 Speed: 0.1 mm/s ~ 1000 mm/s 

 Accel. (Acceleration): 0.1 mm/s2 ~ 2500 mm/s2 

 Don’t stop at this point: This is a setting that allows you to move at a constant speed 

without stopping operation between move commands. For details, refer to Move without 

stopping.  

 

 Joint: The tool movement path between the starting point and the end point is ignored but 

the movement of joint is minimized, instead. 

- Speed: 0.1 deg/s ~ 180 deg/s 

- Accel. (Acceleration): 0.1 deg/s2 ~ 360 deg/s2  
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 Arc: A tool moves along the circumscribed circle whose center is the circumcenter of a 

triangle formed by the starting point(S) and the two points (W1, W2). 

- Speed: 0.1 mm/s ~ 1000 mm/s 
- Accel. (Acceleration): 0.1 mm/s2 ~ 2500 mm/s2 

 

Note The TCP coordinates of the last position held by the robot are the 

coordinates of the starting point. 

 

 Circle: The tool moves along the circle formed by the start point (S) and the two waypoints 

(W1, W2). 

- Speed: 0.1 mm/s ~ 1000 mm/s 
- Accel. (Acceleration): 0.1 mm/s2 ~ 2500 mm/s2  

- Rotation Count: 1 ~ 50 (Default 1) 

 
 

Note The starting point is the TCP coordinates of the robot’s last posture. 
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Radius of Linear 

If you use the radius in linear movement and the next command is linear movement, it moves 

the curve without stopping when moving between commands.  

  

 The minimum radius is zero. If you set the radius to zero, then its path is not a curve. 

 

Don’t stop at this point 

This is a setting that allows the robot to move at a given speed without stopping operation 

between motions. If the currently set move command is Move Linear and the next move 

command is the same straight line motion, the robot will move without stopping.  

 

 If P1 and P2 are linear motion and the radius is 0, the move commands of P1 and P2 should 

be on the same straight line with respect to the start position (S), as above. 

However, if the set travel command does not reach the set speed or if the next move command 

is not on the straight line, an error may occur and the robot program may malfunction or not 

perform.  
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Blending 

Combines with all Move commands to move in series without interruption.  

(It doesn’t support Move C) 

 

 Select Blending (You can’t use it at the same time with Don’t stop at this point function) 

 Enter the radius. The maximum radius is calculated based on the coordinates of the next 

move command as below.  

- Moving path when radius within driving range  

 

 

- Limitation of Radius length  

The maximum length of the radius that can be set is limited to 50% of the shorter distance 

between D1 and D2 that is greater than zero.  

 

Mp : Start point of blending 
Mc : Waypoint of blending and 

the center of radius  
Mn : End point of blending  

D1: (distance Mp & Mc) / 2 
D2: (distance Mc& Mn) / 2 
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Advanced 

The command is used to control digital output while moving. 

 Select Advanced  

 

 Add the digital outputs to control and set the values of them.  

 

Setting the coordinates for movement 

  

To set the movement coordinates, you can either use an absolute value that is fixed in the space 

or a relative value that is relative to the previous location. 

 Fixed Point: The 3D coordinate is received from the robot's coordinate system and used as 

the movement coordinate. 

- Press the Set button to launch the Manual Move screen. For more details about the 

Manual Move screen, refer to 5.3 Manual Move Screen. 
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 Relative: You can set the movement coordinate with respect to the previous location. 

 Variables: You can set the position variable specified as global or local variables. 

Note The inputted coordinate is examined in the control software whether it indicates 

an area where the robot can move to. Even if you entered an input within the 

range, an error can occur when the area is prohibited by the safety setting or 

physical restrictions. 

After setting the coordinates, press the Move button to move the robot arm to the coordinate 

where a tool is set. 

 

Displaying as groups 

If the move commands are repeated two or more times, then you can use one icon to indicate 

them all. 

 

In the flow chart, press the group  button, then they will be grouped as one. The number of 

commands in a group will be indicated by a number at the right top of the group icon. 
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9.8 IF Command 

Use the command to initiate different commands depending on the condition. 

 

 

Enter the condition in an IF statement. 

 

 Press the text box to launch the formula keypad. For more details about the formula keypad, 

refer to 5.4 Virtual Keypad. 

 If you use an IF command, an if statement will be created below the main flow.  

 Select the Use Else checkbox to create an else statement below the if statement. 

 

 Add Else IF to add another condition under the if statement. 

- To add Else IF under IF, then press the + Else IF button. 

- To delete the Else IF statement you added, select the checkbox for the Else IF statement, 

and press the Delete button. 

 If you select the icon on the right side of the conditional statement as shown below, you can 

program to check the conditions of the conditional statement in real time. 

- Even if the IF condition is judged to be true, the condition is checked in real time while 

executing the program. If the condition is False, the execution of the program command is 

stopped and the upper or lower conditional statement is executed.  

- When If is executed 

: If Else is present, execute the program command with the Else condition.     

   If Else is not present, execute the next program command of If.  
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- When ElseIf is executed 

: If ElseIf is present in the child, execute the ElseIf program command that meets the current 

condition.  

   If Else is present in the child, execute the Else program command. 

  
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9.9 LOOP Command 

Use the command to repeatedly execute a series of commands. 

 

 Disabled: Do not use a LOOP command. 

 Always: Repeat execution.  

 Loop input times: Repeat as many times as the entered number. 

- By default, it is set to one.  

- Max: 1,000,000 

 Execute loop based on input: Repeat execution until the condition entered by the 

user is met. 

 Real-time condition check 

Loop condition is judged to be true, and the program corresponding to the condition is 

executed. When the condition is checked in real time and it becomes False, the executing 

command is stopped, the Loop command is stopped, and the next program command is 

executed.  

 

  



Chapter 9 Programming 

147 

9.10 SWITCH Command 

Use the command to execute a different command depending on each specific case. An IF 

command is executed after assessing all the conditions branching to Else IF, but a SWITCH 

command is executed immediately by finding the corresponding case, thus it is much faster than 

execution of an IF command. 

 

1. Using the drop-down menu next to Switch, select a variable. 

For more details about the variable setting, refer to 9.2 Setting Variables. 

 

2. Enter a value corresponding to each case. 

 

 To add a Case, press the + Case button. 

 To delete the Case you added, select the checkbox for the Case and then press the 

Delete button. 

 Click the Break button to select whether use the Break property for each Case statement. 

(Default: Use Break) 
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9.11 WAIT Command 

Instruct the robot to wait for a certain period. 

 

 Disabled: Do not use a Wait command. 

 Waiting time: Enter the duration of waiting time. 

 Digital: Wait until a digital signal is inputted to a specific digital input terminal.  

- For a digital signal, you can choose either of low or high. 

 Analog: Waits until the condition of the value set to a specific analog input terminal is met.  

On analog setting, whether to use the current (A) or the voltage (V) is determined by the unit 

set under the Monitoring menu.  

 Input expression: Wait until the conditional expression set by the user is met. You can 

enter the conditional expression indicating the waiting condition on your own. 
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9.12 SET Command 

You can set the digital and analog output values, assign a specific value to the variable, and 

change the TCP profile in use. 

 

 Disabled : SET command will not be used. 

 SET I/O: Set the output level and the power supply of the tool. 

 SET Variable: Command the variable to be set as a certain value. 

 SET TCP: Command the TCP Setting and Payload Setting. 

 Test : You can perform a test before running the program for the setting items. 
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SET I/O 

If you clicking Edit, an I / O window will pop up where multiple Set commands can be set. 

 

 Redundant I/O : Set the digital output value of the redundant I/O. 

 Digital I/O : Set the digital output value of the digital I/O. 

 Tool I/O: Set the digital output value of the tool I/O. 

 Reverse: Will only be used when the set digital output value is high. After outputting the 

digital output as High for the set duration under Reverse I/O signal setup after, then change 

to Low. 

 Reverse I/O signal setup after: After the input time has elapsed, Reverse operation will be 

performed. 

- Default: 0.1 

- Input range: 0.01 ~ 10 

 MODBUS: Set the digital output value of certain MODBUS. The MODBUS I/O must be set 

under MODBUS TCP of the Device Settings beforehand. 

 Analog : Set a specific analog output value. The output unit used in the setting will be based 

on the analog unit set during monitoring. 

 Tool power : Set the supply voltage of the tool. Supply voltage can be selected after selecting 

Use.  
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SET Variable 

 

 Variables : Assign a specific value to the variable added in the global and local variable lists, 

as well as the register item set in the MODBUS TCP menu. Expression and Assignment can 

be selected. 

 Expression: Assign an expression to the variable. Clicking the Input Expression text box will 

display the expression keypad. Refer to 5.4 Virtual Keypad below for further description of 

the expression keypad. 

 Assignment: Displays the message that was inputted under the Message section during 

program operation, and assigns the value inputted by the operator to the variable. The type 

of the input value will be automatically determined according to the type of the variable, and 

Boolean, Number, String, etc. can be inputted. 

 

SET TCP 

 

 Set TCP: Change to another TCP profile while the program is running using a TCP profile 

saved under the TCP Setting in the Robot Setting. 

 Set the payload: Change the currently set TCP payload to an input value. 

 Use active TCP as center of gravity: Set the currently set TCP coordinate information as the 

center of gravity. 

 

  



Chapter 9 Programming 

152 

9.13 Folder 

Program command icons can be grouped into folders.  

Change Programed Icons into Folder 

 

1. Click the Edit icon.  

2. Select icons that you want to group into folder.  

3. Click the Combine Folder icon.  

 When converting a folder, the folder is created at the last location of the program. 

 

 

Create New Folder 

 

1. In the Commands view, click the Folder icon to create a folder.  

2. Add icons to be programmed under the created folder. 
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9.14 Message 

Displays a user-defined statement or variable in a pop-up or console window.  

The command can be added from the Command Extension tab.  

 

Output format 

 Pop-up: Displays a pop-up window with messages.  

 List: Displays messages in the lower left console window.  

 

Message operation 

 If you set the message format as pop-up, you can specify the operation accordingly.  

 None / Suspend / Stop 

 If pause is set, you can select whether to continue the program from the popup message.  
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Message format 

 User message: Outputs the message the user has entered.  

 Variable output: Selects the variable to which to output the value.  

Select message 

 Write a message in advance and save the text file to the USB in UTF-8 format.  

 Click Select message.  

 Select the created message file and click OK.  

 

 Select the message to use and click Apply.  
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9.15 PATTERN Command 

If the robot repeatedly executes the same task along the same path, you can define it as a pattern 

by using this command. 

Pattern types 

There exist the following five types of patterns. 

     

 Stack pattern: In this pattern, the robot stacks objects while vertically moving with certain 

intervals. 

 Unstack pattern: In this pattern, the robot unstacks objects while vertically moving with 

certain intervals.  

 Line pattern: In this pattern, the robot repeats the same task while moving along the straight 

line with certain intervals.  

 Square pattern: In this pattern, the robot repeats the same task while moving along the 

straight line and in the direction perpendicular to it.  

 

 Box pattern: In this pattern, the robot also repeats the same task vertically which it performs 

in a square pattern. 
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Setting the pattern coordinates 

After selecting a pattern to use, set the coordinates that determine the type of pattern. The 

following image illustrates a box pattern. 

 

1. Select the coordinates to set by starting with number 1. 

 Select the number for the sample image or press the list of the pattern location 

coordinates. 

2. Press the Set Point button. 

 Press the Set Point button to launch the Manual Move screen. For more details about 

the Manual Move screen, refer to Manual Move Screen 

 On the Manual Move screen, enter the final coordinate values. 

3. Proceed with point setting until you reach the last number. 

Setting repeat counts 

For every pattern, you need to set repeat counts between the starting point and the end point on 

each side.  

 

 Count (n): the number of repeated movements on a side 

 Interval (d): the distance that the robot moved each time 

 

Note  If you do not enter the coordinates, the repeat count or the interval will not be 

displayed. 

 When the repeat counts are set, the intervals are automatically calculated and 

displayed. The intervals are not editable. 
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Advanced commands for patterns 

Sets the display of the currently executing index of the pattern, the moving index using the 

variable, and the starting position. 

 

 Start at this position: If 'Start at this position' is checked, the start position is set at the initial 

position of the pattern.  

 Check Location: While pressing this button, move to the position you entered.  

 Select a variable for monitoring: If you want to know the current running index of the 

pattern, you can use a numeric variable to monitor for the current moving index.   

- Starting index: 0 Base 

- After executing the pattern, the monitoring variable is automatically increased by 1.  

 Use the position to move as the setting for the variable 

: Used to move to a specific position using a variable.  

Variables are used together with monitoring variables.  

If starting position and variable movement are used together, starting position is given 

priority. 

Setting pattern points 

If you enter a pattern command in the timeline, then the line to set the pattern point and the  

icon will be added. When each pattern repeats, if you immediately move to the next destination, 

then you can get interfered by an obstacle. So, by using the pattern point setting, you can avoid 

collisions with them and smoothly continue with the next pattern task by selecting a desirable 

tool path.  
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Press the pattern point  icon to launch the following setting screen. 

 

The options for the pattern point settings are the same as the linear movement options in the 

move command section, and additionally you can insert move commands before and after the 

pattern point to adjust the tool path. 

 

Note Only a linear type of move command can be used before and after a pattern point. 
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9.16 Using a Sub Program 

In the main program, you can call multiple sub programs for use. 

Making a sub program 

1. In the flow chart, press the Sub tab. 

 

2. Press the subprogram button in the command menu of the Sub tab. 

 Once the subprogram button is pressed, a new sub program will be created. 

 The name of the sub program is automatically generated. 

 To delete the sub program, press the Delete button at the top or press the Edit > 

Delete button. 

 

3. After pressing the sub program, create a program that will be used as a sub program. 

 Once the sub program is pressed, available commands will appear in the command menu 

and a time line will be created, so that you can prepare a program. 
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Saving and loading a sub program 

After creating a sub program in the Sub tab, you can save it as a file or load the sub program or 

template. 

 

 Keep Sub Program : Even if the original subprogram is changed, the contents of the 

program at the time of loading can be preserved, and even if modified by another 

program that shares the subprogram, the operation at the time of loading the subprogram 

can be preserved without being affected.  

Entering a sub program 

After creating and saving a sub program in the Sub tab, proceed as follows to use it in the main 

program. 

1. Enter the subprogram command in the main program. 

 

2. Press the Sub-program button. 

 After selecting a sub program, the sub program name will be displayed on the button. 
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3. Select a sub program for use and press the Select button. 

 

Once a sub program is selected, the subprogram command will be added to the timeline as 

shown below, and a sub program line will be added at the bottom to indicate the content of the 

sub program.  

In the main program, you can also modify the content of the sub program. Since the sub 

programs in the main and sub tabs are linked to each other, modification made in one of them 

will be also reflected in the other. 

 

Note In the main program, you can modify the content of sub program but you cannot 

save it. If you want to save modifications made for the sub program in the main 

program, you must save it in the Sub tab. 
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9.17 Conveyor Command 

Executes operations linked with conveyor movement.  

Conveyor Setting  

 

 Direction: Set the conveying direction information of the conveyor. Select the line 

coordinates created from the coordinate settings. 

 Position offset: Set the distance to delay tracking start.  

 Conveyor Speed: Set the conveying speed of the conveyor. Select the Number variable or 

type the value directly.  

 Acceleration: Input the acceleration value of the robot for conveyor tracking. 

- Default : 1.000 

- Input range: 0.1~2,500 

 

Conveyor Start Options 

If the I/O set in the trigger satisfies the condition, it starts tracking the conveyor.  

 

 Trigger: Set the I/O and condition that trigger the start of conveyor tracking. Only Digital 

Input is available. 

  



Chapter 9 Programming 

163 

Setting Conveyor Command 

Set the actions to be executed during conveyor tracking.  

 

 During conveyor tracking, the robot moves to the Move position specified by the conveyor 

moving direction. Only Linear Move can be set in the conveyor. 

 When configuring conveyor tracking settings, Down/Up Move is the only possible Move 

direction combination. A combination with other Move directions is not possible. 

 The real-time monitoring function of If and Loop cannot be set for operation during 

conveyor tracking.  

 Conveyor tracking is finished when all work in the conveyor tracking is complete.  
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9.18 VISION Command 

You can communicate with a vision equipment by using the vision data configured in the 

Device Setting menu. 

Setting basic options 

Press the drop-down menu to select a desired vision equipment and set the waiting time and the 

data receiving option. 

 

Setting the movement speed 

Once you have entered the vision command, a vision capture point  and a moving point will 

be created below the vision command. 

 

You can set the vision capture point  on the following screen. 

 

You can set the movement speed/acceleration for a vision camera attached in the robot to move 

to the recording location.  
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 The same input range of speed/acceleration is used as in linear movement. 

 Variable setting: If there is a variable registered by the user, it can be used to store whether to 

recognize the vision. If you select a variable, it stores the success or failure during program 

execution, and you can program it using the corresponding variable in the next program. 

Conversely, if you do not select a variable, when the vision fails, the program will not 

proceed any further. 

 Since the scan position is configured in the Device Setting menu, you do not need to set it 

in the vision command again. 

 Wait time(s): After a vision equipment moves to the recording location, it may require 

some waiting time until the robot arm's position is stabilized. (No waiting time is required 

depending on the robot speed.) Set the waiting time for responses after requesting data from 

a vision equipment. 

- Default: 3 sec 

- Input range: 1 ~ 10 

 Read and Fail Options: You can set the number of data requests in case data receiving 

is unstable. 

- Request count: The input range is 2 ~ 10. 
 

Setting the movement location 

After a vision equipment arrives at the location, you can use an additional Move command to 

adjust the Z-axis for the TCP. You can use a Move command under a Vision command as 

follows. 

 

 The same input range of speed/acceleration is used as in linear movement. 

 The X, Y coordinates and the RX, RY, RZ coordinates used are received from a vision 

equipment and only the Z coordinate can be set to user's preference. 

 

Note If you want to use a tool such as a griper, you will need to input the set 
command additionally. 
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9.19 Thread 

When a robot program is executed, it is possible to execute parallel programs that require IO 

and other controls in parallel with the Main program. However, Move-related commands 

cannot be used. 

Thread Tab 

Select the Thread tab to create a thread. Click the drop-down menu to select the vision device 

you want to use, and set the wait time and data reception options. 

 

 Repeat: Selects whether to repeat the program.  

If it is not checked, thread will be executed just once. 

 Interval: Set the execution interval. 

 

Thread Creation 

Multiple threads can be created. Like a sub-program, each Thread is clicked on as an icon and 

added to the timeline in the lower layer.  

 

Note Commands to control the motion of the robot cannot be used. 
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Event Tab 

Create Thread which has condition. Select the Event tab to create a Event. 

 

 

It’s same with Thread except using condition.  
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9.20 Script 

Provides the function to edit the robot script and set it as a robot command.  

Script Viewer 

Displays a created script. While the program is running, a line currently proceeding in real time 

is displayed on the screen. 

 

 EDIT: You can edit the edit window by opening it.  

 

- Click the Validation Check button to check the integrity of the created script.  

- Manual Control: Operate the robot manually and get the coordinates of TCP, Flange, and 

Joints.  

- Functions : Available functions can be added to Script by clicking on them. 

- Variables: Available variables can be viewed and used.  

Note For script commands, refer to the separate manual. 
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9.21 Path Command 

You can create a motion by holding the robot arm directly.  

Recording Paths 

 

 

1. Starting to record  

Click the button and move the robot arm along the path you want to record.  

During recording, the recording status is displayed in a pop-up window, and can be 

canceled or stopped.  

During recording, you cannot move to another screen or perform other operations.  

If an already created path is found, it will be deleted and a new one created.  

 
 

 

2. Path Playback 
If there is a recorded path, it will perform its motion.  

 S: Move to the beginning of the path.  

 E: Move to the end of the path.  
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3. Apply 
Once you have confirmed the motion, click the Apply button to save it as a file.   

 Speed: Sets the execution speed of the recorded motion.  

 Import: Imports an already recorded motion.  

 Export: Saves the recorded motion separately.  

 Deduplicate path at the ends: If there are the same postures at the start and end points in 

the motion recording process, they are deleted.  

 Delete duplicate paths at Start/End positions: If the same posture exists at the Start and 

End positions during the motion recording process, delete duplicate paths. If activated 

after the motion recording, the motion must be recorded again. 

 

 

Note To execute the recorded motion, the Move coordinates immediately before the 

Path command and the start coordinates of the Path must match. Press the S 

button to move to the start position, and match it with the coordinates of the 

previous Move command. 
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Chapter 10  Starting the Robot 

Starting the robot means that you are powering up the servo motor and get ready for its 

operation. 

Select  Robot Operation in the main menu. 

 

 

Note If your robot is already registered, then it will appear in the initial screen after 

booting up the system.  
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Turning ON/OFF the robot 

You can check the start/end status of your robot at present, and turn on or off the robot. 

 

 ON: Power up the motor for the robot joints and get ready for robot operation. If the robot 

status is ON, then the OFF button will be activated and the ON button will be deactivated. 

 OFF: Power off the motor for the robot joints and enable robot operation. If the robot 

status is OFF, then the ON button will be activated and the OFF button will be deactivated. 

 

Monitoring 

 

 Program Name: Indicate the name of current program loaded. 

 Program Auto Start: It is activated when setting the program auto start condition at system 

startup Managing the Robot System Configuration. For details on the settings, refer to 

15.5 Managing the Robot System Configuration. 

 Variable Monitoring: Displays the name and current value of the variable being used.  
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Checking and setting the robot operation data 

You can check the effective weight applied to the currently selected robot and quickly retrieve 

the saved robot settings and program and apply them to the system. 

 

 Reset: If the robot is malfunctioning or uncontrollable temporarily then initialize the 

controller. 

 Use safety limit check : Enables/disables menu’s safety settings.  

 Active TCP: Indicates currently set TCP information. 

 Load Robot Configuration: A user can load a robot configuration file exported to a 

local storage. For more details about how to export robot settings, refer to 15.5 Managing 
the Robot System Configuration. 

 Tool Power(Voltage): Set the Power of Tool IO. 

 Select Program File: You can select one of the program files stored in a local storage 

and quickly apply it to the system. 
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Operating the robot 

If you want to operate your robot according to the program selected in the operation setting, 

then press the  button in the preview window. For more details about the preview screen, refer 

to 5.2 3D Preview Screen. 

  

If the current coordinates of the robot are different with the start coordinates of the program, a 

pop-up window will be displayed for confirmation.  

 

If there is an obstacle at the start of the current coordinate and there is a possibility of a cllision, 

you can check it and move the robot to the safety position and start.  

 Move: Move robot to start position. 
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 Manual: Manually move robot through the manual control. 

 Play: Start program from current position. If the robot is not at the start position of the 

program, it moves to the start position and the program starts.  

 Cancel : Cancel Playing program.  

 

Locking Screen 

Restricts the operation of the screen during program execution. All operations except screen 

lock button are restricted.  
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Chapter 11  Monitoring 

You can check the selected robot's position/status and I/O status in real time. 

11.1 Monitoring the Robot 

You can check the robot's position and status in real time. 

Select  Monitoring > Robot Status in the main menu. 

Monitoring the robot positions 

In the robot position tab, you can check the position of the selected robot (joint angle and speed) 

and see how it is moving in real time in 3D preview. 
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Checking the robot status 

In the robot status tab, you can check the selected robot's power consumption, voltage or 

current. 

  

Note The monitoring values are displayed when the robot is running normally. 
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11.2 Monitoring Inputs/Outputs 

You can check and set the real time I/O status of robot.  

In the main menu, select  Monitoring > I/O Status. 

Note The monitoring period is 10 Hz. 

 You can check the status of digital I/O by examining the following icons. 

 Digital signal high 

 Digital signal low 

 No signal 

 The input terminals that users cannot adjust the values for and the output terminals that 

users can adjust the values for are marked as follows. 

Input 

terminal 
 

 Output 

terminal 
 

Monitoring controller inputs/outputs 

In the I/O Status tab, the status of signals transmitted to and received from the I/O terminal of 

the controller are displayed in real time. 

 

 You can press the I/O status icons to switch digital outputs to high and low.  For example, if 

you press (High) then it switches to (Low). 
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 For analog outputs, you can press the icon to enter values. 

- Voltage range: 0 ~ 10.00 V 

- Current range: 0.004 ~ 0.02 A 

 You can select either voltage or current as the analog I/O unit. 

- : Voltage(V) is used. 

- : Current(A) is used. 

 If you change the unit of analog output, the output is changed to a minimum. 

 

Note  The number of terminals may vary depending on the controller specifications. 

 If not all the terminals are displayed on the screen, press the  up/down 

scroll button to scroll them. 

Monitoring tool inputs/outputs 

In the Tool I/O Status tab, the status of signals transmitted to and received from the I/O 

terminal of the tool flange are displayed in real time. 

 

 A tool's digital inputs/outputs and analog inputs are set and displayed in the same way those 

of the controller are set and displayed. 

 If you can set the output voltage to a tool, then you can select one from 0 V, 12 V, or 24 V. 

 

Note  The value of the tool's current cannot be configured by the user. 

 If the robot status is servo-off or the emergency stop button is pressed to stop 

the robot, the monitoring screen may display abnormal information. 
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11.3 Utilization 

You can check the robot's system operation time, servo start, and the program operation time 

information. 

Select  Monitoring > Utilization in the main menu. 

 

 Cumulative system operation time: Total cumulative system operation time from 

production time to present  

 

Note The basic unit for collecting the operation time is every hour; as such, there may be 

error of up to one hour.  
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Chapter 12  Device Settings 

You can link your robot to an external equipment such as a PLC, a vision equipment (object 

detection camera), and conveyor system. 

Note Different external equipment is supported depending on the SW version. 

12.1 Configuring MODBUS TCP 

TCP based MODBUS is supported as an extended interface to communicate with external 

devices such as PLCs. It is implemented in software and enables to set lots of IOs. 

From the main menu, select Device Setting > MODBUS TCP. 
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Registering Devices 

To use MODBUS I/O, register a device to share I/O information with. 

1. Press the Add  button. 

  

 

2. Enter following information in the Add Device screen and press the Add button. 

 Device Name: Enter the device name to be displayed on the screen. 

 IP Address: Enter the IP address of the device. 

 Slave ID: Enter the slave ID of the device. Its input range is 0 to 255 in the 3-digit 

integer form. 

 Description: You may enter the description for the device. You can enter up to 25 

characters. 
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Editing/copying the device settings 

You can modify settings for a device previously registered or copy the device settings to use as 

settings for a new device. When copying, I/O information of the device is also copied. 

1. Press the Edit  button from the list of registered devices. 

 

2. Modify items you want to change and press the OK button. Or, press the Copy button if 

you want to copy the device settings to use as settings for a new device. 

 When you press the Copy button, the settings of the device currently selected and 

information of I/Os under the device are also copied and added to the list. The name of 

the newly created device is the name of the device copied from with '_number' added. 

 

 

  



Chapter 12 Device Settings 

186 

Deleting a device in the list 

1. Select a device to delete from the list. 

 Check the check box for the device. 

 

2. Press the Delete  button, and then press the OK button. 

 When you delete a device, I/Os for the device will be deleted as well. 

 

 

Registering I/O 

After you registered a device, you must set an I/O or I/Os for it. The I/O(s) added is(are) used to 

read a certain value from the device or to send HCR status values to it. 

The type of I/Os for the MODBUS are as follows: 

 Digital Input: Reads digital values (High/Low) from a device. 

 Digital Output: Sends digital values (High/Low) to a device. 

 Register Input: Reads 2-byte values (0-65535) from a device. 

 Register Output: Sends 2-byte values (0-65535) to a device. 
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1. Select a device to add an I/O to from the device list. 

 When a device is selected, I/Os currently added to it are displayed. 

2. Press the Add  button. 

 

3. Enter information of the I/O and press the OK button. 

 Name: Enter the user identifiable name of the I/O. 

 Signal Address: Enter the pre-defined address to be used for the I/O. 

 Type: Select Digital I/O or Register I/O. 

 Frequency: Select the frequency of data transmission for the I/O. Available frequency 

values are 0, 1, 2, 5 and 10. 

 

 

Note You can use I/Os when you make a program.  Especially, you can use 

register-type I/Os as variables in a program. 
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Viewing the communication status 

After an I/O is registered, you can view its communication status. 

 

 

 Normal 

 Unable to connect 

 Input value error 

 Device response delay 

 Address error 
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Viewing and setting the I/O values 

After an I/O is registered, you can view or set its value. 

 

 Digital Input: Indicates an icon for the digital value (High/Low) currently being input. 

- : High 

- : Low 

 Digital Output: Indicates an icon for the digital value (High/Low) currently being output. 

Press the value to change it. 

- : High 

- : Low 

 Register Input: Indicates the value currently read from the device. 

 Register Output: Indicates the value being currently sent to the device. Press the value to 

change it. 

 

 

Editing I/O settings 

1. Press the Edit  button of an I/O to be modified from the I/O list. 

2. Modify the settings and press the OK button. 

 

Note It is not allowed to change the I/O type. To change the type, you must delete the 

I/O setting and add it again. 
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Deleting I/O 

1. Select an I/O to delete from the I/O list. 

 

2. Press the Delete  icon. 
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12.2 Using a Vision System 

You can register the vision to be linked to the robot and configure necessary settings. 

In the main menu, press  Device Setting > Vision System. 

 

To interwork with the vision, the following two steps are required.  

 Vision System Setting 

- Communication Setting: To send and receive data to and from the vision system, data is 

exchanged via TCP/IP communication. The vision system should be set up to use TCP/IP 

communication.  

- Exchange Data Format (Protocol) Setting: To exchange data with the robot system, the 

type and format of the data sent from the vision system should be set as follows. 

 Data Communication Protocol 

The data format consists of a string, which is set up to be transmitted by the vision system in 

the following conventions. 

 

TJG , X , Y , TH CR LF 

 TJG: Result value from object recognition in the vision. 1(Success) or 0(Fail) 

 X: X coordinate value of object recognized by the vision 

 Y: Y coordinate value of object recognized by the vision 

 TH: Rotation theta value of object recognized by the vision 

 CR, LF: Separator for the end of data 

 Comma(,): Separator for each item 
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 Robot System Setting 

- Interworking vision setting: Sets the model and communication connection information of 

the vision to be interworked. 

- Vision workspace setting: One vision camera can have a number of vision work areas, and 

by using the information set by the 'Vision workspace setting,' the vision coordinates 

recognized by the vision are converted into the robot coordinates to move the robot. 
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12.3 Adding and setting vision equipment 

Adding a vision equipment 

Press the Add button. They will be added under names such as Vision1, Vision2 to the list and 

they become configurable. 

Setting a vision equipment 

 Name: Enter the equipment name. (The length of name is limited to 15 letters and special 

characters cannot be used.) 

 Model: Select the manufacturer for your vision equipment. 

- Omron vision 

- Cognex vision 

- Hostar vision 

- Keyence vision 

- Baumer vision 

Note Different vision equipment is supported depending on the software version. 

 

 Connection info: Enter the TCP/IP address and the port number necessary for 

communication between a vision equipment and the robot.  

- Range of port number: 0 ~ 65535 

- Press the Connection Test button to check the status of connection with a vision 

equipment by using the connection data. 

Note To perform the connection test correctly, the vision system and our system 

must be connected to a single network before the test.  

 

 Vision Type: Select a type of vision installation. 

- Embedded: Attached to the robot arm. 

- Stand Alone: Fixed to another location and detached from the robot arm. 
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12.4 Setting Vision Workspace 

Vision workspace setting sets information to change the vision coordinate recognized by the 

vision to the robot coordinates. Up to 5 workspaces can be set for one vision. 

Adding Vision Workspace 

 To add a vision workspace, select the vision already added from the vision list. 

 When you click the Add vision workspace  button, the following workspace setting 

screen appears. 

 

 Name : Enter a name for the vision workspace. The input range is up to 15 characters, and 

no special characters are allowed. (Exclude '-' and '_'.) 

 Vision Scan Coordinates: If the vision type is Embedded, the setting is necessary for 

moving the robot arm to the scanning location. 

- Press the Move button to move the robot arm to desired location and view it there. 

- Press the Set Point button to launch the manual control screen. For more details about 

the manual control screen, refer to 5.3 Manual Move Screen. 

 Rotation Offset: If the vision type is Stand Alone, you can set the angle between the 

robot's location and the scanning location, so that the rotational angle for an object 

necessary for a gripper to hold it. Press the Set Offset button to automatically set the 

rotation offset. For more details, refer to the next page. 

 Vision Test: Test vision with the set values. 
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 Set Points: It matches the number of guide image and is activated by clicking the number. 

The initial value is ‘0’. At each number, enter the robot coordinate values and the 

coordinates of the vision system at that point. Range : -10000~10000(Pixel) 

 Rotation Direction Setting: Sets the rotation direction of the object recognized by the 

vision. 

Note When attaching the vision to the robot arm, attach the upper left / upper right / 

lower right directions shown on the setup screen so that they match the directions 

shown in the vision software. 
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Understanding rotation offsets  

When a vision equipment scans an object, the angle of shifted position for an object is used the 

reference for a vision equipment. Thus, the angle data of object that a vision equipment sends to 

the robot is obtained from the perspectives of vision equipment. Now, if the robot does not 

know the angle between the scanning location and the its position (rotation offset), then the 

robot will assess the scanned angle data from its own perspectives and use a gripper accordingly, 

thus making it hard to pick up an object accurately.   

As shown below, if the scanning location is same as the basic TCP location of robot (A) all it has 

to do is to rotate the gripper angle by as much as the angle of scanned object. However, if the 

scanning location is shifted by X degrees from the robot base, then when an object is scanned, 

although a vision equipment detects the angle of object as same as from the location (A), its 

gripper will have to rotate by X degrees to pick it up. In other words, from the robot's 

perspectives, it is same as if an object is shifted by X degrees, so, a rotation offset is required to 

compensate for the angle of object sent from a vision equipment. 

 
When the scanning location and the robot's location are on the same line 

 

 

When the scanning location and the robot's location are shifted by X° 
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Chapter 13  Environment Setting 

13.1 General Setting 

You can select the desired UI language and unit also set the time/date. 

In the main menu, press  SW Configuration > General. 

 

 Language Selection: You can select a language for the UI. (Supported languages: 

Korean, Chinese, English, Turkish, German, Spanish, French, Hungarian, Italian, Dutch, 

Polish) 

 Units Selection: You can select units of weight. 

 Date & time settings: You can set the system date/time. 

 Calibrate Touch Screen: If it is hard to touch a desired location on the screen, then you 

can correct the touch locations. 
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Note The language and unit settings are immediately applied to the system without 

restarting it, but the time/date are applied to the system after restarting it. 

13.2 Network setting 

You can configure the network settings for Ethernet communication of your operation 

software. 

In the main menu, press  SW Configuration > Network. 

 

 DHCP: IP address is automatically assigned. 

 Static IP: Fixed IP address is used. 

 Obtain DNS server address automatically: DNS address is automatically received. 

 Use following DNS server address: Use the DNS server designated by the user. 

 Do not use: Do not connect to the network. Use it as standalone. 

 

Note For more details about network settings, consult with your system network 

administrator. 
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Chapter 14  Turning Off the System 

14.1 Shutting Down the Operation Software 

To shut down the operation software, proceed as follows. 

1. Select  SW Configuration > Shutdown in the main menu.   

2. Press the OK button. 

Note  You can press the power button of the teaching pendant to shut it down. 

 If the operation software does not shut down properly, press and hold the 

power button of the teaching pendant for 5 to 10 seconds. 

 

 Caution 

Shutting down the system improperly may cause problems for the software. 

If the software has a problem after abnormal system termination due to the reason that the 

system is forcefully turned off by the power switch or the Power button of TP, or the power 

is out, contact local distributor. 

14.2 Turning Off Controllers 

After shutting down the operation software, press the power switch to turn off the controller. 
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Chapter 15  Maintenance 

15.1 Inspection Items and Periods 

Periodic inspections are required to maintain the robot in the best condition for a long period of 

time. An inspector should prepare and execute an inspection plan. 

The following items require periodic inspections. If you found some problems during 

inspections, and you can resolve them on your own, contact Hanwha Precision Machinery Co. 

Inspection item What to inspect Periods 

Robot 
arm 

All 
Check if the robot moves to the desired 

destination according to the program. 
Daily 

All Remove stains, dusts and pollutants. 3 months 

All 
Check if the robot arm or tool sags when you 

turn on/off the servo power. 
Daily 

Main 
bolts 

Check if the bolts exposed to the outside of 

the robot is loose. 
3 months 

Motor 
Check for abnormal heat generation or 

noises. 
Daily 

Controller 

Cable Check the cable connections. 

6 months Internal Remove dusts from the inside. 

Filter Remove dusts from the filter. 
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15.2 Checking the Robot Arm 

Inspection period 

Inspect at least once every 6 months. The inspection period may vary depending on the 

inspection area. 

Checking and cleaning the robot arm 

1. Move the robot arm to home. 

2. Turn on the controller. 

3. Check the followings. 

 Check the cable connecting the controller and the robot arm. 

 Check if the screws exposed outside is loose or unfastened. 

 Check for defects in the motor, the brake and the decelerator. 

4. Remove stains, dusts and pollutants. 

 

15.3 Checking the Controller 

If dusts accumulate inside the controller, electrostatics or overheating can cause product 

malfunctions. Periodically check the inside of the controller and clean off dusts and check if the 

internal cables are connected properly. 

Inspection period 

Inspect at least once every six months. 

Note The inspection periods may vary depending on the installation environment. 

Checking and cleaning the controller 

1. Turn off the power for the controller. 

2. Open the cover for the controller. 

3. Check if there are dusts inside the controller. 
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4. If there are dusts, then use a vacuum cleaner to carefully remove dusts. 

5. Check if the connector cables are connected properly. 

 

Cleaning and replacing the filter 

The controller has an air suction hole and an air discharge hole, which have dust filter mounted 

in them.  

 

Separate the filter from the controller and use a vacuum cleaner or air compressor to remove 

dusts. 
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15.4 Viewing and Managing Logs 

You can view and manage the logs for the operation system. 

Select Management > Log in the main menu. 

 

Deleting Logs 

Press the Delete button and the log data found will be deleted. 

Exporting Logs 

1. Press the Export button. 

2. Select the location to export the logs into and press the OK button. 

 

When export is finished, a folder in the form of 'date-time' is created at the selected location, 

and the log data are saved in the folder along with the robot configuration and program files. 
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15.5 Managing the Robot System Configuration 

You can save the robot configuration in a local or external storage device or retrieve the saved 

robot configuration from them. 

In the main menu, select  Management > Setting Management. 

 

Packaging posture 

 Arrange the posture of the robot in a position that allows it to be placed in the delivery box.  

 The robot only operates while the button is pressed.  

 The posture depends on the model of the target robot.  

- HCR-3: [J1:0, J2:-90, J3:-160, J4:-90, J5:180, J6:0] 

- HCR-5: [J1:0, J2:-90, J3:-160, J4:-90, J5:180, J6:0] 

- HCR-12: [J1:0, J2:-90, J3:-150, J4:60, J5:180, J6:180] 
 

Factory reset 

 Initializes the system to its factory settings.  

 A warning message is displayed twice before the reset is performed.  

 When the factory reset is complete, the system restarts.  

Note If you perform a factory reset, all information including the robot information will 

be deleted. Please back up the necessary information before you perform a reset.  
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Use Default Program 

Set the program and configuration file to load automatically when the robot is booted.  

It provides Servo On and program start function automatically after booting.  

 Check Use Default Program to activate it.  

 Select the program to be loaded among the stored programs.  

 Set the condition of Auto Start Program on System Startup.  

 Select Initial Setup File to use among the saved configuration files.  

 Set the condition of Auto Servo.  

Note The available inputs are Digital Input or Digital Input of Modbus TCP.  

Exporting the configurations 

You can save the following settings by exporting them. 

Robot Setting 
TCP Setup 

Mounting 

Safety Setting 
Motion Limit 

Safety Boundary 

I/O Setup 
Digital I/O 

Analog I/O 

1. Select the file path to export. 

 Press the refresh  button to update the storage list and the file list. 

2. Press the filename input field and enter the filename. 

 Filename is limited to 25 letters, and empty character is not allowed. 

3. Press the Export button. 

4. When the confirmation window appears, press YES. 
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Importing the configurations 

1. Select the file path for importing. 

 Press the refresh  button to update the storage list and the file list. 

2. Press the Import button. 

3. Select the configuration items to import and press the OK button. 

 You can select multiple items. 

 If you want to deselect it, press it again. 

 

4. When the confirmation window appears, press YES. 
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15.6 Software Update 

You can update the robot software. 

In the main menu, press  SW Configuration > SW Update. 

 

 

Cautions during update 

 Update can be performed using the external storage device only.(The USB memory may not 

be compatible depending on the manufacturer) 

 If you connect a USB drive to TP, as there is a lot of data, the software may not be updated 

normally. Be sure to connect directly to the controller. 

 Update files may be composed of multiple files instead of a single file. For proper update of 

files, do not modify the name or path of an update file package arbitrarily. 

 The update function is not available for general users but for the user with a certain authority. 

If you need an update, contact Hanwha Precision Machinery or a local service center. 
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Updating software 

Check the version of the software and proceed as follows: 

1. Connect the external storage device (such as the USB memory) where the update files are 

stored to the USB port of the teaching pendant or the controller. 

2. In the software update screen, press the Import button. 

 

3. Select an update file in the correct location and press the OK button. 

 The extension of the update file is "tgos", and the update file name contains its version. 

The file selection window displays applicable files only. 

 

4. From the software update window, press the Update button. 

 

When the software is updated, the system restarts. 
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Appendix A Warranty 

Refer to the contract between the sales team and you. 

Warranty 

Our company guarantees specifications, quality and reliability that our customer demands 

during the warranty period. 

Warranty period 

One year since the date of equipment purchase (varies depending on the contract between our 

company and you.) 

Limitation of Liability 

 If a problem occurs after the customer mounts an unauthentic part in our product, our 

company will not be responsible for it. 

 If your product has a fault deemed as our company's responsibility, we will immediately 

repair it or replace the product with a good one. 

 

 

  



 

212 

Appendix B Certification 

Safety 
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MD (Machinery Directive) 
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LVD (Low Voltage Directive) 
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EMC (Electro Magnetic Compatibility) 
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Cleanroom-Body 
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Cleanroom-Controller 
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Appendix C Dimensions for Installation 

HCR-3 
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HCR-5 
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HCR-12 
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Appendix D Tool Flange Cross Section 

The tool flange is designed suitable for ISO9409-1-50-4-M6. 

 

HCR-3 
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HCR-5 
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HCR-12 
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Appendix E Port Pin Map 

Ports in the tool flange have the following specifications. 

 

HCR-3 

 Tool I/O: SACC-DSI-M8FS-8CON-M8/0,5 – 1458790 

 

Port Layout Pin number Signal Color 

Tool I/O 

 

1 Analog Input Ch 1  White  

2 Analog Input Ch 0 Brown 

3 Digital Input Ch 0 Green 

4 Digital Input Ch 1 Yellow 

5 0/12/24 Vdc  Gray  

6 Digital Output Ch 0 Pink 

7 Digital Output Ch 1 Blue  

8 Ground Red 
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HCR-5 

 Tool I/O: SACC-DSI-M12FS-12CON-M16/2,0 – 1458790 

 EtherCAT: SACC-DSI-MSD-4CON-M12/0,5 SCO – 1551901 

 

Port Layout Pin number Signal Color 

Tool I/O 

 

1 0/12/24 Vdc Brown 

2 Ground Blue 

3 Digital Output Ch 0 White 

4 Digital Output Ch 1 Green 

5 Digital Output Ch 2 Pink 

6 Digital Output Ch 3 Yellow 

7 Digital Input Ch 0 Black 

8 Digital Input Ch 1 Gray 

9 Digital Input Ch 2 Red 

10 Digital Input Ch 3 Violet 

11 Analog Input Ch 0 Gray/Pink 

12 Analog Input Ch 1 Red/Blue 

EtherCAT 

 

1 TX+ Red 

2 RX+ White 

3 TX- Orange 

4 RX- Blue 
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HCR-12 

 Tool I/O: SACC-DSI-M12FS-12CON-M16/2,0 – 1458790 

 EtherCAT: SACC-DSI-MSD-4CON-M12/0,5 SCO – 1551901 

 

Port Layout Pin number Signal Color 

Tool I/O 

 

1 0/12/24 Vdc Brown 

2 Ground Blue 

3 Digital Output Ch 0 White 

4 Digital Output Ch 1 Green 

5 Digital Output Ch 2 Pink 

6 Digital Output Ch 3 Yellow 

7 Digital Input Ch 0 Black 

8 Digital Input Ch 1 Gray 

9 Digital Input Ch 2 Red 

10 Digital Input Ch 3 Violet 

11 Analog Input Ch 0 Gray/Pink 

12 Analog Input Ch 1 Red/Blue 

EtherCAT 

 

1 TX+ Yellow 

2 RX+ White 

3 TX- Orange 

4 RX- Blue 
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Appendix F System Specifications 

Note It is recommended to warm up the robot when the temperature of the driving environment is 

10 ° or less. At low temperatures, Grease can cause the robot to stop or degrade performance. 

 

HCR-3 

Degree of freedom 6 

Base weight 3 kg 

Working radius 630 mm 

Joint rage ±360°(J3: ±160°, J6: ±Infinited) 

Repeatability ±0.1 mm 

Weight 13 kg 

Bottom area size Ø128 mm 

Temperature 0 – 50° 

IP class IP64 (Robot Arm) / IP20 (Robot Controller) 

Power supply 100 – 240 VAC, 50 – 60 Hz 

 

  Controller Tool connector 

I/O port Digital input 16 2 

Digital output 16 2 

Analog input 2 2 

Analog output 2 - 

I/O power supply Controller: 24 V 2 A 

Tool Connector: 12 V or 24 V 1.6 A 

External communication TCP/IP, Modbus TCP, 

CC-link / Profinet / Ethernet / IP (Gateway needed) 

Cable length Robot arm to controller connection cable: 6 m 

Teaching pendant to controller connection cable: 5 m 
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HCR-5 

 

Degree of freedom 6 

Base weight 5 kg 

Working radius 915 mm 

Joint rage ±360°(J3: ±165°) 

Repeatability ±0.1 mm 

Weight 20 kg 

Bottom area size Ø150 mm 

Temperature 0 – 50° 

IP class IP54 (Robot Arm) / IP20 (Robot Controller) 

Power supply 100 – 240 VAC, 50 – 60 Hz 

 
 

  Controller Tool connector 

I/O port Digital input 16 4 

Digital output 16 4 

Analog input 2 2 

Analog output 2 - 

EtherCAT - 1 

I/O power supply Controller: 24 V 2 A 

Tool connector: 12 V or 24 V 1.6 A 

External communication TCP/IP, Modbus TCP, 

CC-link / Profinet / Ethernet / IP (Gateway required) 

Cable length Robot arm to controller connection cable: 6 m 

Teaching pendant to controller connection cable: 5 m 

 
 
 
  



 

233 

HCR-12 

Degree of freedom 6 

Base weight 12 kg 

Working radius 1300 mm 

Joint rage J1 : -180°≤ rz1 ≤ +180°,   J2 : -165°≤ rz2 ≤ +135° 

J3 : -85°  ≤ rz3 ≤ +245°,   J4 : -190°≤ rz4 ≤ +190° 

J5 : -170°≤ rz5 ≤ +170°,   J6 : -360°≤ rz6 ≤ +360° 

Joint speed J1 : 130°/s,   J2 : 130°/s,   J3 : 200°/s 

J4 : 200°/s,   J5 : 200°/s,   J6 : 200°/s 

Repeatability ±0.1 mm 

Weight 52.5 kg (Robot Arm) / 20.2 (Robot Controller) 

Bottom area size 220mm × 227mm 

Temperature 0 – 45℃ 

Humidity RH20% - RH80% (Non-condensate) 

IP class IP54 (Robot Arm) / IP20 (Robot Controller) 

Power supply 100 – 240 VAC, 50 – 60 Hz 

Installation Floor, Ceiling 

 

  Controller Tool connector 

I/O port Digital input (TYPE) 16 (PNP) 4 (PNP) 

Digital output (TYPE) 16 (PNP) 4 (NPN) 

Analog input 2 2 

Analog output 2 - 

EtherCAT - 1 

I/O power supply Controller: 24 V 2 A 

Tool Connector: 12 V or 24 V 1.6 A 

External communication TCP/IP, Modbus TCP, 

CC-link / Profinet / Ethernet / IP (optional) 

Cable length Robot arm to controller connection cable: 6 m 

Teaching pendant to controller connection cable: 5 m 
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Appendix G Stopping Time and Distance 

Stopping time and distance for stop category 1 

The robot configuration to measure the stopping time and the stopping distance for the stop category 1 is as 

follows: 

 Position: Maximum load position (the position of the robot arm fully stretched horizontally to make the 

maximum load) 

 Speed: Maximum joint speed (maximum speed of 180°/sec which can be generated at the robot joint) 

 Payload: Maximum load possible to be installed on the TCP (3kg/5kg/12kg) 

The behavior to measure the stopping distance for the joint J1 was driven in parallel to the ground and joints 

J2 and J3 were driven perpendicular to the ground. The stop category 0 was performed when each joint 

reached its maximum speed. 

It takes 0.03 sec for the brake to be engaged for deceleration after the stop signal is detected. 

 

 

 

 

  

Maximum Joint  
Speed 

(180 deg/s) 

Speed (deg/s) 

Maximum Stopping Time 
Time (s) 

0.030 
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HCR-3 

 Stopping Distance (deg.) Stopping Time (sec.) 

Joint J1 23.496° 0.270 

Joint J2 23.412° 0.270 

Joint J3 23.465° 0.270 

Joint J4 46.990° 0.270 

Joint J5 47.000° 0.270 

Joint J6 47.020° 0.270 

 
 
HCR-5 

 Stopping Distance (deg.) Stopping Time (sec.) 

Joint J1 23.261° 0.270 

Joint J2 23.412° 0.270 

Joint J3 23.310° 0.270 

Joint J4 23.495° 0.270 

Joint J5 23.502° 0.270 

Joint J6 23.450° 0.270 

 
 
HCR-12 

 Stopping Distance (deg.) Stopping Time (sec.) 

Joint J1 16.953° 0.270 

Joint J2 16.910° 0.270 

Joint J3 25.622° 0.270 

Joint J4 26.086° 0.270 

Joint J5 26.081° 0.270 

Joint J6 26.084° 0.270 
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Stopping time for stop category 1 

The robot configuration to measure the stopping time for the stop category 1 is as follows: 

 Position: Maximum load position (the position of the robot arm fully stretched horizontally to make the 

maximum load) 

 Speed: Maximum joint speed (maximum speed of 180°/sec which can be generated at the robot joint) 

 Payload: Maximum load possible to be installed on the TCP (3kg/5kg/12kg) 

Create a behavior to stop regardless of the speed and the payload so that it comes to a full stop after a certain 

period (0.270sec). 
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Appendix H Error Codes 

Code Cause Actions 

10001 
The operation software has a server 

connection error. 
Restart the system or ask the administrator. 

10002 

An error occurs while the operation 

software communicates with the 

server. 

Restart the system or ask the administrator. 

10005 A DB connection error. Restart the system or ask the administrator. 

10006 
Controller update server connection 

error. 

Check the EPC and controller board connection cable 

or check the access information.  If the same problem 

persists, then ask the administrator. 

10007 

A data tx/rx error occurs while the 

operation software communicates 

with the controller. 

Check the EPC and controller board connection cable 

or check the access information.  If the same problem 

persists, then ask the administrator. 

10008 

A communication error (heartbeat) 

occurs between the operation 

software and the controller. 

Check the EPC and controller board connection cable 

or check the access information.  If the same problem 

persists, then ask the administrator. 

20001 A system initialization error.  Restart the system or ask the administrator. 

20006 
Vision equipment fails to detect an 

object. 

Check the recording setting for the vision camera and 

check if it detects objects properly. 

20007 
An error occurs while receiving data 

from the vision equipment. 

Check the vision equipment connection information 

and the cables. 

30002 
The operation software does not 

support the feature currently. 

Check the software version installed in the system and 

ask the administrator. 

30005 
A pattern initialization error occurs 

while running the program. 
After checking the pattern settings, try again. 

30008 
An error occurs while retrieving the 

file. 

If the file is retrieved from an external storage device, 

then check the connection to it. 
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Code Cause Actions 

30010 
An error occurs while exporting the 

file. 

If the file is retrieved from an external storage device, 

then check the connection to it. 

40001 
Infinite loop is found while running 

the program. 

After checking the program logics, make sure to avoid 

an infinite loop. 

100002 

The robot cannot be paused 

(without motion operation), and 

you cannot execute a pause 

command. 

If the program is in the pause state with the robot 

operation already stopped, send the program stop 

command and continue the next operation. 

100008 
An error occurs while calculating 

the time for inputted motion. 
Check the motion's input value and try again. 

100017 

A communication error occurs 

while sending the program's 

command data (motion). 

Check the network cable and restart the system. 

100018 

A communication error occurs 

while sending the program's 

command data (stopped). 

Check the network cable and restart the system. 

100019 

A communication error occurs 

while sending the program's 

command data (I/O). 

Check the network cable and restart the system. 

100020 

A communication error occurs 

while sending the program's 

command data. 

Check the network cable and restart the system. 

100021 
A communication error occurs 

while sending the robot data. 
Check the network cable and restart the system. 

100022 

An error occurs while establishing 

communication between the 

controller and the EPC. 

Check the network cable and restart the system. 

100037 

The robot cannot move to the 

destination indicated by the 

transmitted command. 

Check the command input and try again. 



 

239 

Code Cause Actions 

100047 

You cannot execute the current jog 

command because the robot is still 

operating. 

Check that the robot operation is fully stopped and 

retry it. 

100048 
At present, the robot is violating the 

safety settings (border, joint range). 

Disable the safety setting in the operation menu and 

use manual control to move the robot into the 

working range that complies with the safety settings. 

For normal operation, check the Enable Safety Setting 

item before use. 

100051 

The speed input for the currently 

transmitted command exceeds the 

max speed limit. 

Check the input for the command and try again. 

100052 
The speed input for the currently 

transmitted command is zero. 
Check the command input and try again. 

100053 
The currently set speed limit is zero, 

so the robot may not move. 
Check the safety speed limit. 

100057 

An error occurs while using the 

inputted point data to calculate the 

TCP. 

Reset the point for TCP calculations. 

100059 A speed input error. Check the speed input range (0 ~ 1.0 (100%)). 

100061 
Cannot execute the currently 

inputted motion command. 

Reset the current motion settings such as location and 

speed. 

100075 
The currently inputted motion's 

joint speed is zero. 
Enter the joint speed greater than zero. 

100076 
The currently inputted joint speed 

violates the max speed limit. 
Reset the joint speed input. 

100077 
The currently inputted joint speed 

violates the speed limit. 
Reset the motion's joint speed or speed limit. 

100078 Jog control speed violates the limit. Check the speed limit settings. 

100079 
Jog control speed violates the limit 

for the robot. 
Check the speed limit settings. 
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Code Cause Actions 

100080 The joint speed limit is set to zero. Reset the joint speed limit input. 

100100 
An error occurs while calculating 

the inputted motion (circular). 

For circular motion setting, check the start/mid/end 

location inputs. 

100101 

An error occurs in the radius value 

while calculating the inputted 

motion (circular). 

For circular motion setting, check the radius input 

value. 

100102 
An error occurs while calculating 

the inputted motion (circular). 

For circular motion setting, check the radius and 

input values. 

100103 
An error occurs while calculating 

the inputted motion (circular). 

For circular motion setting, check the radius and 

input values. 

203100 
The operating robot's joint exceeds 

the range of safety operation. 

Press the reset button in the operation menu and move 

the robot into the permitted working range. 

For normal operation, check the Enable Safety Setting 

option before use. 

203101 
The joint's safety speed exceeds the 

limit. 

Reset the safety speed in the safety setting menu or 

adjust each motion speed in the program to meet the 

speed limit. (The problem may occur while moving 

even if the speed and acceleration of each motion are 

entered within the allowed ranges. You must find the 

speed and acceleration of the motion normally 

operating.) 

For items related to safety setting, ask the 

administrator with the Admin authority to login as 

the Admin and set them. 

203102 
The joint's safety acceleration 

exceeds the limit. 

If the servo is off due to an error, then turn on the 

servo in the operation menu and adjust each motion's 

acceleration in the program to meet the safety setting. 

(The problem may occur while moving even if the 

speed and acceleration of each motion are entered 

within the allowed ranges. You must find the speed 

and acceleration of the motion normally operating.) 
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Code Cause Actions 

203103 

This is a one-time error that can 

occur when excessive torque is 

applied to the joint drive. 

You can ignore a one-time error. If the same error 

persists, then you need further analyze the robot's 

drive and motor conditions and take additional 

actions. 

203104 

This is a one-time error that can 

occur when excessive torque is 

applied to the joint drive. 

Press the reset button in the operation menu and try 

again. If the same error persists, ask the administrator. 

203105 Out of the range of safety border.  

If the servo is off due to an error, then turn on the 

servo in the operation menu, (if the servo is still off. 

then disable 'safety limit' and try to turn on the servo 

again) and use manual control to move the robot into 

the permitted working range. 

For items related to safety setting, ask the 

administrator with the Admin authority to login as 

the Admin and set them. 

203106 
Cannot move the robot to the 

destination that is inputted. 
Check the position, speed and pose of the motion 

280000 

The operation or control software is 

down or a communication error 

occurs due to a cut in the cable. 

Check the network cable connection.  Restart the 

operation software.  If the operation software 

malfunctions, then force it to stop and restart it. 

280001 

A communication error between the 

controller board and the robot 

(EtherCAT). 

Press the reset button in the operation menu and press 

the start button after several seconds to turn on the 

servo motor. If the problem persists, then press and 

release the emergency stop button for the TP, press 

the reset button and check if the Start button is 

activated in the Operation menu after several seconds 

and check operation of the controller. 

If the system does not operate normally despite of 

actions taken as above, restart the system. 

280002 Drive error 

Use the device log in the Log Inquiry screen to inquire 

about the axial number that is causing errors. Press 

the reset button in the operation menu and see if the 
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Code Cause Actions 

start button is activated after several seconds. If not 

activated, press and release the emergency stop button 

for the TP, press the reset button and check if the Start 

button is activated in the Operation menu after 

several seconds and check operation of the controller. 

If the system does not operate normally despite of 

actions taken as above, restart the system. 
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Email robot_inquiry@hanwha.com 
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	Preface
	Copyrights
	Table of Contents
	Chapter 1  Product Overview
	1.1 Collaborative Robot System
	1.2 System Components
	1.3 Basic System Configuration
	1.4 Overview of Robot Arms
	1.5 Overview of Robot Controller
	1.6 Overview of Teaching Pendant
	1.7 Axial Coordinates and Operational Range
	1.8 Robot's Working Range
	HCR-3
	HCR-5
	HCR-12

	1.9 Maximum load capacity for the tool
	HCR-3
	HCR-5
	HCR-12


	Chapter 2  Safety
	2.1 Safety Marks in the User Manual
	2.2 General Safety Cautions
	2.3 Intended Use
	2.4 Potential Dangers
	2.5 Limitation of Liability
	2.6 Transportation
	2.7 Emergency Stop
	2.8 Safety Fence
	2.9 Limits of Speed and Rotational Angles
	2.10 Operating Robots without Driving Power
	2.11 Safety Controller
	2.12 Risk Assessment

	Chapter 3  Installation
	3.1 Installation Locations
	3.2 Installation Types
	3.3 Fixing Robots
	3.4 Connecting Tools to Robots
	3.5 Connecting Cables
	3.6 Fixing the Controller Box
	3.7 Overview of Controller I/O
	3.8 Common Spec for Digital I/O
	3.9 Configuring the Safety Input
	3.10 Configuring the General Digital I/O
	3.11 Configuring the General Analog I/O

	Chapter 4  Getting Started
	4.1 Turning on the Robot Controller
	4.2 Turning on the Teaching Pendant

	Chapter 5  Software Overview
	5.1 Menu Overview
	5.2 3D Preview Screen
	5.3 Manual Move Screen
	5.4 Virtual Keypad

	Chapter 6  Registering Robots and Users
	6.1 Managing Robots
	6.2 Managing Users
	6.3 Login/Logout
	6.4 Checking Status

	Chapter 7  Setting Robots
	7.1 Setting the Robot Installation Angles
	7.2 Setting TCP
	7.3 Setting Inputs/Outputs
	7.4 Coordinates
	7.5 Setting Global Variables
	7.6 I/O Bit Operation

	Chapter 8  Safety Settings
	8.1 Limiting Robot Movement
	8.2 Setting Safety Boundaries
	8.3 Setting Tool Boundaries
	8.4 Setting Redundant I/O
	8.5 Setting Safeguard I/O
	8.6 Exceeding Safety Limit of Joints

	Chapter 9  Programming
	9.1 How to Use Commands
	9.2 Setting Variables
	9.3 Editing programs
	9.4 Managing a Program
	9.5 Using Templates
	9.6 Applying programs
	9.7 Move command
	9.8 IF Command
	9.9 LOOP Command
	9.10 SWITCH Command
	9.11 WAIT Command
	9.12 SET Command
	9.13 Folder
	9.14 Message
	9.15 PATTERN Command
	9.16 Using a Sub Program
	9.17 Conveyor Command
	9.18 VISION Command
	9.19 Thread
	9.20 Script
	9.21 Path Command

	Chapter 10  Starting the Robot
	Chapter 11  Monitoring
	11.1 Monitoring the Robot
	11.2 Monitoring Inputs/Outputs
	11.3 Utilization

	Chapter 12  Device Settings
	12.1 Configuring MODBUS TCP
	12.2 Using a Vision System
	12.3 Adding and setting vision equipment
	12.4 Setting Vision Workspace

	Chapter 13  Environment Setting
	13.1 General Setting
	13.2 Network setting

	Chapter 14  Turning Off the System
	14.1 Shutting Down the Operation Software
	14.2 Turning Off Controllers

	Chapter 15  Maintenance
	15.1 Inspection Items and Periods
	15.2 Checking the Robot Arm
	15.3 Checking the Controller
	15.4 Viewing and Managing Logs
	15.5 Managing the Robot System Configuration
	15.6 Software Update

	Appendix A Warranty
	Appendix B Certification
	Appendix C Dimensions for Installation
	Appendix D Tool Flange Cross Section
	Appendix E Port Pin Map
	Appendix F System Specifications
	Appendix G Stopping Time and Distance
	Appendix H Error Codes

